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I have been watching the Ubuntu community put
together Dapper Drake over the past six months.
This is the latest Ubuntu/Kubuntu distribution. I am
certainly not new to watching Linux distributions
evolve, but this one seems to be different.

One difference is, of course, that Linux in 
general grew up. Sending Pat Volkerding a 
private message about a bad assumption related 
to a proprietary CD drive ten or so years ago 
was more like the norm. Today, in any of the
“desktop-oriented” distributions, the feedback 
is much more likely to be about an application
than an incorrect hardware assumption.

Dapper Drake has had seven pre-releases. By
pre-release, I mean a complete version of the distri-
bution available for download. I have been running
it since the second one on one of my systems. That
means I have had an opportunity to see all the warts
and watch how they were addressed. For me, this
has proved that open-source development works on
a very large scale.

Many years ago, when Linux was “just for
geeks”, I remember an argument over how
Microsoft could afford different hardware and lots
of people to do testing before they released a new
version of its software. The general response was
that although Microsoft could hire people and buy
computers, Linux had the advantage that there
were thousands of people all over the world with
different hardware testing Linux every day.

Well, that is what has happened with Dapper,
except I would guess the numbers involved were
larger. While I used the pre-releases every day, by
the time I discovered a bug, it always had been
reported already, and in many cases, the fix was
already available simply by running the automatic
update program.

Now, although the idea of bug reporting and
fixes available on-line is not unique to free software,
the ease at reporting the problem and the speed
that it is addressed is unparalleled in the proprietary
software market. This is mostly because Linux has an
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By purposefully reaching out to users, projects like Ubuntu and Django increase
user participation, which leads to more user satisfaction and better software.

PHIL HUGHES
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open model, where anyone can get the
software source and anyone can report a
problem, encouraging people to partici-
pate rather than just trying to find a way
around a problem.

Although some may read this as a
sales pitch for Kubuntu, that isn’t my
intent. I do think Kubuntu is one of the
best desktop distributions going these
days, and each release proves to me
that it is moving forward rapidly. The
real point is that any software project
where users are encouraged to partici-
pate—that is, their input is valued—will
have an advantage over a proprietary
approach as far as addressing the
needs to the customer.

Let me offer another example. 
There is a framework for rapidly 
developing Web sites called Django
(http://www.djangoproject.com).
Although it’s a rather geeky project, it
has addressed user participation in an
open but different way from Ubuntu.
Django has three active discussion
groups: one for developers, one for
users and one for announcements of
changes. It also has a Web page to
report bugs.

The final part of Django’s participatory
system is the way users get new versions
of the software. It employs a tool called

Subversion that lets users get the updates
by entering a simple command. But,
making the updates work with your
system is the best part. You get simple
directions, so that you have to do
exactly nothing. That is, even if you are
running the test system, the update
automatically gets included immediately.

In the cases of Ubuntu and Django,
the social aspect of these projects may be
the most important. By encouraging user
input in this manner, the division between
users and what they use is eliminated.
You, as a user, will be more likely to take
the time to offer constructive criticism
rather than say, “I paid for it so fix it.” On
the other end, developers will have more
appreciation of you as the user and see
more value in their work if this inter-
change can happen.

In the Linux community, this isn’t
new. When there was one Linux news-
group on Usenet, you could see users
“grow up”. That is, you might notice
someone asking a real newbie question
and then, a week or a month later, see
them answering newbie questions.
Trickle-down economics don’t seem to
work; however, trickle-down knowledge
on open-source software does.

Now, does this mean you should use
only Ubuntu and/or write Web applica-

tions using only Django? No, not at all. As
I said in the beginning, this is my recent
experience. Debian, the distribution upon
which Ubuntu is based, has been doing
this forever. The difference is that the
average Debian community member is
much more technical than the average
Ubuntu community member. Fedora and
OpenSUSE are also community-oriented.
I expect that also is true of many of the
other, “not-free” distributions.

When you go looking for the distri-
bution that is the best fit for you, take
these ideas into consideration. Maybe
you don’t want to participate, for
example. You would rather send a
check and get the support you need.
That’s not a bad thing—someone needs
to be paying the bills. But, you still
need to look beyond the propaganda
and see how support really works. Talk
to current customers and get some
ideas. Paying doesn’t always mean you
get what you pay for.

Finally, good news for TUX readers
and general KDE users. Starting with
Dapper Drake, Canonical will now send
out free copies of Kubuntu as well as
Ubuntu. When you go to the Web site
(https://shipit.ubuntu.com) you are now
offered a choice.�

Phil Hughes is Group Publisher for SSC Media Corp.
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This is a strange way to start, but words
can get us into trouble. It’s strange
because I intend to use words to describe
why words can get us into trouble. I wish
you could simply download my thoughts,
but that project isn’t available yet from
the Free Software community. Through
the Letters section, I get to read quite a
few uses of one word that causes me grief.
It causes me grief, and I think it creates a
lot of trouble for new Linux users. What
is that word? The word is free.

The potential for trouble arises
depending on who uses this word 
and whether he or she believes in 
the ideals behind the Free Software
Foundation. What are some of those
ideals? Taken directly from the Free
Software Foundation Web site,
http://www.fsf.org, the most funda-
mental of these ideals is the free 
software definition:

We maintain this free software
definition to show clearly what
must be true about a particular
software program for it to be
considered free software.

Free software is a matter of 
liberty, not price. To understand
the concept, you should think of
“free” as in “free speech”, not
as in “free beer”.

Free software is a matter of the
users’ freedom to run, copy, dis-
tribute, study, change and improve
the software. More precisely, it
refers to four kinds of freedom, for
the users of the software:

1) The freedom to run the pro-
gram, for any purpose (freedom 0).

2) The freedom to study how the
program works, and adapt it to
your needs (freedom 1). Access to
the source code is a precondition
for this.

3) The freedom to redistribute
copies so you can help your
neighbor (freedom 2).

4) The freedom to improve the
program, and release your
improvements to the public, so
that the whole community benefits
(freedom 3). Access to the source
code is a precondition for this.

In this editorial, I don’t want to
debate the virtues of the free software
definition, nor am I attempting to
sway anyone to “convert” to the
ideals of free software. Instead, my
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Building a bridge for new Linux users will require research, planning and acceptance.

KEVIN SHOCKEY
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concern lies in the vast chasm that
exists between those who embrace the
free software ideals, who care about
what the word free means and why it
is important to software, and the much
larger community of software users
that aren’t interested in anything other
than whether the software works and
the cost of that software.

Let’s imagine that these two points
lay opposite each other—one on each
side of a gorge. Our goal is to build a
bridge between these two points, so
that communication can flow freely
and effectively between each of these
points. What we hope to avoid is for
each side to start building a bridge
from its side, get halfway, and then 
discover the two bridge pieces don’t
connect in the middle. To accomplish
our goal, we’ll have to do a little
research and planning to orchestrate
our bridge building so that it success-
fully joins together the two sides.

To start our research, we have to
first examine each of these two sides
and understand their perspectives. Once
we understand the perspectives, we can
begin planning our bridge. This plan-
ning process must identify and accept
any assumptions discovered and yet still
successfully draw up a plan that will

unify the two sides. The challenge in
our planning is to accept that the per-
spectives of both free software idealists
and new users are not likely to change
significantly. In a large way, these fixed
perspectives create most of the misun-
derstandings that I encounter.

Let’s begin our research by examin-
ing the stereotypical new Linux user. If
you’ll forgive the gross generalization,
this profile serves only to make a point.
However, the model for this profile is
based on personal experience and the
model we have here at TUX for the new
Linux user. There’s a wide range of time
most TUX readers have been using
Linux. Our target audience includes
some Windows users who are still within
the “wait and see”, preliminary
research phase of using Linux, but the
bulk of our audience has been using
Linux anywhere from a few months to
two or three years. We have some very
experienced Linux users as well. With
this initial group, these people may
have seen Linux running on another
computer, but they have not installed
Linux on a computer they own.

Now for the generalities: the new
Linux users we target are typically not
power users, therefore they are not
drawn to more technical Linux maga-

zines. As a rule, the people in this group
are mostly interested in the computer
working with little or no involvement 
on their part. The familiar phrase often
heard from members of this group is 
“I just want everything to work.” Many
of the benefits made available from free
software (freedoms 0 and 2) hold no
interest for this group.

For me, when I think of new Linux
users, I imagine that they see a com-
puter as only a tool—a complex tool
that should make some tasks easier to
accomplish. Like most people, members
of this group have been using comput-
ers for a while, mostly Windows, and
mostly proprietary software. Through
this use, they have formed habits—pat-
terns of how to accomplish certain
tasks. So, when they say that it should
just work, what they actually mean is
that it should work exactly how they
have been conditioned to complete a
particular task. Although I’ll give away
my age here, I remember a time when
everyone who used a personal computer
was accustomed to a command-line
prompt—how times have changed. The
joy of the PC and MS-DOS was that it
was still significantly more efficient,
even liberating, compared to not using
a PC to complete some of these tasks.
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My final generalization is that few
members of this group ever will want to
contribute within any of the software
development communities that produce
free software.

Continuing our research, when we
look for generalities to describe advo-
cates of free software, one would first
have to read some background essays by
Richard Stallman and others to better
understand how members of the Free
Software Foundation (FSF) perceive soft-
ware. These essays are available on-line
at http://www.fsf.org/licensing/essays.
One thing that you can guess from read-
ing a few of these essays is that while
attempting to be nontechnical, most of
the essays are very technical. For many,
the stereotypical free software advocate
is extremely technical. Within this group,
typically everyone enjoys the four soft-
ware freedoms.

Members of this group prefer to use
only GNU Public Licensed software,
which guarantees the freedom of that
software. For this they are willing to
accept any extra time spent or lack of
efficiency, if any, that results from using
that software. Because they might be
more technically inclined, they don’t
mind if it is necessary to tweak the soft-
ware, learn new habits and even become

involved in the software development
communities to improve that software.

Finally, to understand this group, we
also must revisit the free software defi-
nition to clear up two myths. These
myths also are a major reason for the
chasm between these two perspectives.
As I mentioned in my introduction, the
misuse of the term free is troublesome,
so we should take care to use it correctly.
First, I have the unique experience of
living in a society where Spanish is the
first language. Here, free software is
called software libre, libre is from the
root word libertad, or liberty. When
you receive something without paying
for it here, it is gratis. To bring this full
circle, for the FSF, free software does
not mean something you get without
paying for it. It is software that is pro-
vided with certain freedoms (the four
software freedoms)—the freedom of
choice—in other words, liberty. Second,
nowhere does the free software defini-
tion guarantee that software will be
gratis, or free of charge.

Now, let’s do some planning, and
see if we can’t get our bridge built. It
should be clear from reading some of
the free software essays and thinking
about the free software definition that
a great deal of thought and planning

has already been done. Therefore, we
cannot expect any compromise or
change to the free software ideals.
There has been one attempt to soften
the ideals held by the FSF, and the
result was the open-source definition.
Although all free software is open
source, the reverse is not true.
Although their goals often align, the
FSF is clear in distinguishing itself from
the Open Source Initiative.

When we look at new Linux users,
and maybe expand our profile to
include new free software users, I see
the following trend. For the most part,
although not required, most free soft-
ware is also available without a fee.
Most new Linux users are very happy to
obtain all of this free, gratis, software.
So much so, they forget about the
freedoms guaranteed by the GPL with
which much of it is licensed. Linux, or
more appropriately GNU/Linux, is one
such software guaranteed by the four
software freedoms. Because those in
the new user group think of the com-
puter only as a tool, it’s easy to forget
about those freedoms—even more so
when the price is right, $0. If I give you
a hammer without charging you, you’ll
probably not be interested if I were to
tell you that the knowledge necessary

P2P

7www.tuxmagazine.com

http://www.fsf.org/licensing/essays
http://www.tuxmagazine.com


to reproduce that hammer was guaran-
teed to be available. Anyway, you just
got one without paying for it, so you’d
probably be able to get another one if
everyone knows how to make them.
However, if you were someone that loved
to make hammers, those guarantees
might be very important.

As this trend continues, more and
more people will want to use free soft-
ware. Although this software continues
to improve, it will not evolve quickly
enough for the majority of new Linux
users to satisfy their conditioned use of
their computers. Linux and the host of
free software will never replicate the
experience millions of Windows users
currently receive. Back in the late 1980s
as personal computers were switched
from MS-DOS to Windows, there was a
mass migration of users that required
massive training and the elimination of
many old command-line habits. We are
now on the brink of a new migration, and
whether the current Windows community
or the new Linux user community
agrees, they will have to adapt to the
new realities of mass migration to Linux
and free software.

For some, this may come sooner than
expected. July 11, 2006 is the last day

Microsoft will publicly support Windows
98, Windows 98 Second Edition and
Windows Millennium Edition (Me),
http://support.microsoft.com/gp/lifean18.
In addition, Microsoft will no longer pro-
vide security updates, creating a signifi-
cantly increased security risk for users of
these operating systems. What can we
expect when millions of users of these
operating systems migrate to Linux? Will
they embrace Linux and free software
with full knowledge of the true meaning
of free software, or will they be blinded
by the potentially low price tag?

In conclusion, I’ll share my plan to
build our bridge. First, we need to
accept that a change is coming—first
Windows 98, 98SE and ME. Next, how
many users will be able or willing to
upgrade their hardware to meet the
requirements for Vista? Very quickly,
how many of you have a computer
with at least a gigahertz processor, at
least 512MB of RAM, a video card with
at least 64MB of RAM, and who knows
how much, but maybe a 120GB hard
drive or more (http://www.microsoft.com/
technet/windowsvista/evaluate/hardware/
vistahardware.mspx)?

Second, if you are uncomfortable
with the introduction of more choice,

more complexity and more personal
responsibility, become familiar with the
leaders of the companies that package
Linux for new users, such as Linspire,
Mandriva and Xandros. They are going
to be your best bet. Third, if you’re not
going to choose from one of the previ-
ous vendors, be prepared to get more
involved with your computer. You will
have to learn new tools, and you will
find it hard initially, but in the end,
there won’t be any regrets. You will
find that after an initial productivity hit,
you’ll be back up to speed before you
know it. The bottom line, however, is
that you will have to change. Microsoft
will not release the source code for its
obsolete operating systems. Very soon,
millions of users of these obsolete
operating systems will have to change.
There is no way to avoid this future.
Lastly, the biggest challenge may fall
onto the Free Software community. It
will have to expect a massive increase
in the demands for support, improved
software usability and more software
releases, as all of these new Linux and
free software users become acclima-
tized to the other side of the chasm.�

Kevin Shockey is Editor in Chief of TUX.
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A TUX Fan Offers a Suggestion for 
Obtaining Linux Distributions
First, let me say, great mag! I have been doing Linux and UNIX
since the 1980s, but I still am a newbie with many applications
and so on. Your magazine is both fun (Mango Parfait is very
funny!) and helpful.

In the February 2006 Letters, Owen Berio reports on a problem
that many have—poor bandwidth! A service I have been using
for a few years now to get Linux, http://budgetlinuxcds.com, has
started a new service where you simply send them a list of URLs,
and they will download and burn to CD/DVD and mail it to you.
Their services have been excellent and very reasonable so far—
haven’t tried this one yet, but would bet it is also good. Thanks
for the great mag and for saving trees!
--
Tom Bigford

Request for Printed Version of TUX
I started my PC experience with a magazine called PC Novice,
which has now evolved to PC Computing. I still subscribe, because
the articles continue to be written in the plainest and most
detailed manner for those of us who are not nerds. I even give
gift subscriptions to friends who are experiencing their first PC.

This brings me to my point—many of us older duffers have
become addicted to hard-copy material. This being the case 
personally, I would like to know if there are any plans to issue 
a subscription-based printed copy of TUX magazine?
--
Owen

A Stark Description of Linux Adoption 
and the Challenges Encountered
This in reference to your earlier write-ups and the one in the
June 2006 issue of TUX by Kevin Shockey [see “Introducing the
New Linux International”] about Microsoft’s FUD campaigns.

In India, most computer users just want the system to “work
out of the box”. I have rarely come across users who would
want to extract more performance out of their boxes. This is rel-
egated to the fan-boy clubs and hobbyists who make it happen
for themselves. Either way, no one bothers about the “locked-in
formats”, because of wide-spread piracy. Microsoft is more keen
to have users working on its OS than to shift en masse to Linux
or any other alternative platform.

The major target for the International Software Alliance has
been corporations who use pirated versions on the sly. Huge
fancy sticker prices may work for corporations that can absorb
the cost of the product; what is the rationale for giving out
“student editions” or free products to schools and colleges? It is
clearly aimed at locking out any alternative. This perverse action
is essential for the corporations’ own survival.

Primarily in India, most computers are assembled by local guys
acquiring “spare parts” and selling them more cheaply than
branded products like HP, Dell and so on. This is the reason the
branded products have hardly made any dent and the majority
of their sales come from the government/business sector. The
government in India (or its agencies) remain the largest buyers
of computers, and this is where the money is.

LETTERS
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Microsoft is running expensive print ad campaigns (I have never
seen such a splurge of the ads ever from its stable) and is keen
to partner with the local assemblers (for “Genuine Software
Initiatives” by paying a hefty commission) and lock in the branded
players. The branded players offer “Free DoS” to keep the
product prices low on some models to entice the customers.

In this give and take, Linux doesn’t feature greatly. The distro
is usually an outdated version of Mandrake or just a plain
shell kernel minus the GUI. I have hardly seen any live
demonstrations on the Linux-based PCs, and every dealer
would be “obliged” to load up pirated versions of Windows.

This is the broad outline, in my opinion. The initiative has to
come from the government to move its processes to open
source and extend the benefit of the same to the public. The
callous media has to mention the benefits and advantages over
the existing proprietary formats and create a felt demand for the
product. A strong initiative has to come from those who design
the school curriculum to make introduction to Linux mandatory;
thus, some students might get motivated to discover it on their
own. The status of Linux-based magazines is really disappoint-
ing. Most of the write-ups get juvenile treatment, and their
treatment of the subject remains confused.

The problems are indeed manifold, but there seems to be
some ray of hope on the horizon. Life Corporation of India
(LIC) is one of the largest government-owned and run life
insurance companies. It recently migrated to Red Hat. The
exact details are elusive, but definitely worth emulating.

The choice of distro may be debatable though. In my opin-
ion, the shift might have been prompted by the assurances

of enterprise support. Your magazine can highlight such
developments through its sister publications (since this could
be out of place for a newbie-based magazine). I am sure that
this can be highlighted via editorials. The idea behind this is
to build up opinion in favour of Linux and open source.
--
Dr Abhishek Puri

Clarification for OpenTTD Review
I just read the article about OpenTTD in the June 2006 issue,
which is a game I love and have been playing for a year or so on
my Linux computer. Contrary to what is stated in the article, I do
not need the original game to play OpenTTD.

By installing the game with autopackage (http://autopackage.org),
I do not need to copy any files or even own the original
game. By navigating to http://autopackage.org/packages,
finding the openttd package and downloading the file
http://www.familie-kirchhofer.de/openttd/autopackage/
openttd-0.4.7.x86.package, the installation amounts to 
typing sh openttd-0.4.7.x86.package and entering the
root access code two times.

I hope you will note this or something similar in the next issue,
as this game is so great, everyone should know that it is freely
available and does not require any parts of the original game.
--
Thomas R. N. Jansson

Student Requests Help for 
Web Development Applications
I hope that I am directing this letter to the right person. I am 
a student at a university in Sweden, studying for a major in
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Computing/Web Design. I run Linux at home and have tried a
lot of different distributions—probably around 20 during the
past year, though I have grown very found of Ubuntu, mostly
for the great forums. Now to my problem at hand—in most
courses I take, the applications used are for Windows. Most of
them I can find alternatives for in Linux, but for some of my
tasks, I experience great problems.

The primary one is Flash. I would find it very interesting to
read an article on this matter—such as, “Toolbox for Web
Developing” or something like that. I realize that this, of
course, would be hard to do with all the different applications
out there. But, maybe give a hint as to which applications can
be used for PHP, ASP.NET, Flash and more. There must be some
Web designers out there who aren’t using Windows or Mac
OS. Thank you for a great magazine!
--
David Vikstrom

First of all, you may want to check our sister magazine,
Linux Journal, for more information regarding development
tools. However, I’ll give you a few pointers to get you start-
ed. To develop pages in PHP, there are some vendors like
Zend and Active State that might have some good tools;
otherwise, you’ll want to use a plain-old text editor—maybe
vi, with syntax highlighting or KDevelop for KDE.
Monodevelop is going to be your best bet for ASP.NET
development. Finally, although there are a few open-source
projects listed on SourceForge for Flash development, last
time I checked (more than a year ago), they were not ready
for prime-time use. However, you may want to give them
another look.—Ed.

A Reader Offers Praise and Suggests 
Some Video and Animation Tools
First, thank you for having so graciously published my letter
[June 2006]. It makes me feel like someone’s out there listen-
ing. I’m glad to see that you will be publishing an article on
Scribus as well. Seeing as how you are planning a Media
Center issue in August 2006 (if I’m not too late), I figured I
would put a bug in your ear about some Linux apps that
seem to—or have potential to—get the job done. Granted,
I’m not a video professional but I know what works for me:

ZS4 (http://www.zs4.net): for this one you need the manual
and all the tutorials to wrap your head around it, but it is
indeed very powerful. The programmers are also musicians
and (it appears) created this software to make their own
music videos. Users will need their t@b encoder to encode
other formats of video files into the format that ZS4 uses to
edit, which is motion PNG (not MNG—motion PNG, as in
“motion JPEG”). The GUI is not the most user-friendly, but it
makes sense after you go through a few tutorials.

Jahshaka (http://www.jahshaka.org): I mentioned this one in
my last letter, and since then, the RC3 update has been
released. It seems pretty solid now. It now has more options
for importing as well as taking advantage of the FFmpeg
update to export video in SWF format. Jahshaka is a motion
graphics and limited 3-D animator, as well as an NLE software
and text generator.

Blender (http://www.blender3d.org): there’s not much more I
can say about this one; go to http://www.blendernation.com to
see some of the wondrous work being done with Blender.
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Wings3D (http://www.wings3d.com): a fantastic open-source
modeler; model in Wings3D, then animate in Blender.

Just thought I’d try to make a contribution to your efforts.
--
Graphixgeek

A Frustrated Reader Shares 
His Perspective on Linux Usability
Why I keep going back to Microsoft: TUX magazine, is with-
out a doubt, an answered prayer for me. Finally, an “under-
standable” Linux magazine that focuses on more than just
OpenOffice.org, Firefox and Thunderbird—a genuinely useful
magazine with  real-world Linux users in mind. Each month,
I can’t wait for the new issue to come out. It’s so good (dare
I say it...), I would be willing to pay a reasonable amount to
continue on as a subscriber if it came down to it!

Robert Smits’ Letter to the Editor on page 9 of the June
2006 issue is right on the mark. I fully agree with him; if
Linux supporters are truly serious about displacing Microsoft
Windows as the predominant computer desktop, they’re
going to have to put their egos aside and make the installa-
tion of Linux programs understandable!

Several times over the past two years, I’ve dabbled with vari-
ous Linux distributions and always headed back to Windows
because of how incredibly difficult it was to load new soft-
ware, or upgrade the software that came with a particular
Linux distribution.

I am not interested in being a Linux super-geek. All I want to
do is load the software and get on with business! I don’t

want to spend countless hours trying to understand some
vague and cryptic terminology, trying to make sense of what
some FAQ is trying to relate, struggling to “compile” down-
loads, pounding my fist against the desk and asking why
KPackage and Synaptic aren’t working the way the article
said they’re supposed to and so on.

Even when I do find “understandable” information on the
Web, often times the screen shots, illustrations and other
items are out of date, as the program or distribution has been
upgraded to something that hardly resembles the illustration
shown on the Web site.

I buy Linux books only to find either: 1) they’re written at
such a basic level as to be an insult (for example, “this is
how you resize a window, this is what a word processor
does, this is how you shut down your computer”) or  2) 
the book is so over my head in technical details that it might
as well be written in Hindi! Where’s the middle ground in
Linux books?

Finally, out of total frustration (once again), I remove Linux from
my computer and reallocate the disk space back to Windows.
Then, a few months latter, something about Linux captures my
interest, such as KOffice 1.5. So, I once again approach MEPIS
or SUSE to see if things have improved any—only to...once
again...end up saying to myself “the hell with it” after spending
3–4 hours struggling to get MEPIS or SUSE to load KOffice 1.5
successfully (as one of many such examples).

Do you honestly think that following these episodes of wast-
ed time and complete frustration that I would speak favor-
ably about Linux? Especially to other small-business people
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who, like me, are interested only in using a computer pro-
ductively? The best advertising any organization can get is
positive “word of mouth” between people. And, until Linux
gets its act together and makes software installation as
straightforward as Microsoft has, Linux supporters will never
see their dreams of displacing Windows become a reality.
--
Ken

An Impassioned Linux User 
Pays His Respects to Windows
I discovered Linux a couple of years ago and have loved it ever
since. I still use XP for games, but everything else is Linux. My
daughter has Edubuntu, and I use Kubuntu on my desktop
and various other distros on my laptop test machine. I figure if
it runs all the peripherals on my on Toshiba 7010CT, it will run
on anything. I never pass up on a chance to introduce people
to the delights of Linux and open-source software.

To my point, and please don’t get me wrong, I love Linux and
the freedom it gives me, but I feel that the Linux community
does have one thing that it owes Microsoft. If it wasn’t for
Microsoft, there would not be so many PCs in people’s homes
capable of running Linux in the first place. If you recall, until
Microsoft started producing an OS that you could, as a home
user, install on almost any hardware ranging from the high-
end shop-bought PCs to the home-built geek boxes, there
were only home computers with built-in proprietary OSes that
tied you into buying both software and hardware from a few
selected suppliers for that particular brand of machine. Think
of Amstrad, Apple, Atari, Commodore, Sinclair, Oric and BBC
computers to mention a few. Microsoft software enabled the
non-techy public to purchase a PC and use it for something

meaningful and not be tied to one particular piece of hard-
ware. For the first time, the home user could properly upgrade
machines without having to buy a whole new computer, and
the OS for the most part, drivers allowing, would take the
strain of the burgeoning upgrade industry.

Without the possibility to use a wide variety of software and
hardware, there would not now be what was considered a
business-only machine, sitting in so many homes around the
world, on which the general populous could install Linux!

How different would the home computer industry be if it weren’t
for the likes of Microsoft opening the way for IBM-compatible
PCs to make it in to people’s homes? I feel the only real mistake
that Microsoft made was getting too greedy. It has the lion’s
share of business and home use sewn up, and yet it still charges
a huge premiums for software.

The Linux community needs to grow up and get professional,
and stop playing the Microsoft game of slating the opposition.
What it needs to do is start removing the reasons people have
for sticking with Microsoft in the first place, settle on a couple of
desktop environments and pump as much development into
them as possible. Get all of the hardware industry to recognise
Linux as a legitimate alternative to Windows and supply drivers
for the hardware. Get more game producers on board, as let’s
face it, if people wanted only to write a letter they could use a
typewriter. If I could go out and purchase more decent games for
Linux, I would love it, and I am sure that I am not the only one.

If Linux wants a piece of Microsoft and Apple’s playground,
it needs to get down to the gym and beef up its profile for
starters! Why not get some of the big boys of the Linux
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community to put together an ad campaign for example?

Please keep up the good work at TUX, I have read it since issue
2, and I love its openness and friendliness.

I know that I might get a slating for these comments, and 
I don’t suppose for a second that there would be enough
room in the publication to post this letter, but thanks in
advance for reading it anyway.
--
Mick Cassell

Praise and a Distribution Recommendation
(Zenwalk) from France
I’ve been using only GNU/Linux and other open-source soft-
ware for several years now, so I’m not a newbie anymore,
but I still have a lot of things to discover. Your magazine is a
great help to accomplish this goal.

I’m a member of a local LUG in France, and I particularly liked
the article in the May 2006 issue titled “Linux’s Fundamental
Difference”, because this is, in essence, the idea we are
spreading. To go a step further in your direction, let’s study the
situation in France. For your information, there is a new law
(DADVSI) that promotes DRM to protect music/movies/software
and protects their skirting from a legal point of view. These
DRMs are generally software that controls the usage of, not
only the access to, the file they protect. To enforce their 
efficiency, they should be rooted in the OS and even in the
hardware (think of Sony’s rootkit and TCPA/Palladium). My
point is that the problem with DRM is exactly control: the
more DRM you accept, the less control you have, even if the
hardware/music/movie is yours since you bought it!

Another remark, I discovered the April 2006 issue and in partic-
ular the “Distro Smackdown” articles, thanks to the letters from
readers. I agree that testing could have been more fair, but I
know it is a difficult thing to do with small resources. So, I will
not enter discussion about that. I would simply suggest that
some newbies test the Zenwalk distro (http://www.zenwalk.org).
It is based on Slackware, with graphical package management
tools and graphical configuration tools. Moreover, the installa-
tion is simplified, in the sense that you install (quickly—in 25
minutes) a light and minimal, but fully functional, OS, and then
add packages you want using the graphical tools.

In my opinion, this is the best distro, because several levels of
expertise in its use are possible in parallel. On the one hand,
newbies can use it even if they don’t know GNU/Linux, using
only the graphical tools, and on the other hand, experts can
install packages manually and can modify by hand the (very
easy-to-understand/well-commented) scripts. Another advan-
tage is that you don’t have to wait for the availability of any
distro-dependent package to be able to use software. The
packages available range from Zenwalk .tgz to Slackware .tgz,
and even the direct sources. You can also install .rpm and
.deb using alien, but I would not recommend that.
--
G. Muller

Problems Building MPlayer? Try KPlayer
MPlayer is arguably the best media player available for
Linux. But, I am having considerable problems with package
dependence, and so far, I can’t install it. I guess rpm will not
work, and I will have to go for a tarball (I use SUSE 9.0).

Can the guys at MPlayer make a .tar file, just as Firefox is
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doing nowadays, so I can just unzip it, and run it? I hate to
reboot to Windows for viewing AVI files. I don’t know why
these guys compile MPlayer and so on for Windows. This
tends to make Linux unnecessary.
--
Nihal Arju

I would recommend trying to install KPlayer. That should get
you the AVI file playback that you want. If not, you might
want to try VLC Media Player. Both of these should be 
available through Synaptic.—Ed.

A Call for a VectorLinux Review
When I saw that you are planning on doing a review on
Slackware, I thought you might be interested in looking at
VectorLinux too. Maybe you recall that I was trying to install
Linux on some old hardware, and VL5.1STD did the trick.
And like it says on the VectorLinux site, it is fast, even on 
a PII with 64MB.

One of the other things I like about VectorLinux is that it
doesn’t have a RTFM policy on the forum. Even the most
obvious question is answered, and if the answer is already
on the forum, they will point you to it (politely) and give you
suggestions on how to do better searches (politely).

Slackware, like you said, is not popular for newbies, but
maybe VectorLinux can help make the transition easier. 
You may need to use CLI once in the while, but most of 
the administration tools already have a GUI front end. 
(See http://vectorlinux.com.)
--
Nelson

This topic is something I’ve become very interested in. As I
mention in my editorial this month, with July 11 looming large
on the horizon, we need to help people find their way from
these legacy operating systems to Linux. So, I appreciate the
recommendation.—Ed.�
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Thank you for your nice questions this month. I have many
more questions this month than last month, and I like that very
much. Please send me more. I like to have too many questions
because I get to pick the easy ones! I am teasing you. I pick
easy questions and hard questions.

I am surprised to get many questions from people who run
Windows and Linux. Why are you running Windows? Do you
play games on Windows you cannot play on Linux? This is a
good reason. I do not know another good reason except if
your boss makes you run Windows. Otaku runs Windows
because he cannot stop playing games all the time and he likes
some Windows games. I like some of the games he plays too.
But I do not need to play the games like he does.

I like the games on the GameCube and the PlayStation 2 better
than the games on the PC. I think the PlayStation 3 is going to
have better games than games for the PC. I give many hints to
Otaku to buy me a PlayStation 3 when it is ready. Otaku, are you
reading this? My birthday is over already but you can still buy me
another present. Can you guess what present I want?

I do not know if the games for the Xbox 360 are good, but I
know that the power supply for the Xbox 360 gets very hot.
Otaku complains that I do not cook for him enough. Maybe Otaku
will give me an Xbox 360 so I can cook on the power supply. But I
think that is a very expensive cooking machine. I think a rice cooker
or electric skillet is cheaper and will work better for cooking.

I am done cooking the answers to your questions and the
answers are ready. I hope you like the taste.

Q Dear Mango, to be honest, your Mango style of writing
used to annoy me! I guess it must take some time to

get used to. I seem to be over it now! I have been using
Linux only since March of this year. I installed Fedora Core 5
and immediately formatted my Windows drive. Bye Bye! I
have never been happier! Well except for GNOME—these
GNOME dwellers are quite whiney! I quickly made the switch
to KDE. I do not like GNOME. Oh alright, on to the question.
In Windows, I used to have to do OS maintenance: Scandisk,
Defrag, Disk Cleanup and things of this nature. I have read
that the Linux filesystem does not need defragging. So, what
system maintenance needs to be done to keep my system
purring?—Dwight, Olympia, Washington

A Dear Dwight Olympia, please do not cry. When you say
“Bye Bye!” to Windows, you can say “Bye Bye!” to

scandisk, defrag and those other headaches. I know about
only one defrag utility, and it is very outdated because
nobody needs it. I will not make you go to sleep by telling
you the technical information about Linux filesystems and
fragmentation. But Linux filesystems do not fragment very
much. Even if you can figure out how to know that your
disk is fragmented, you should not worry about this frag-
mentation. Linux filesystems store and access information in
a different way from Windows filesystems. So, Linux does
not slow down even when your disk fragments.

I have a server that has been running for almost ten years. I
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use this server very much every day. If a disk gets fragmented,
the longer you use it, my disks on this server must be very frag-
mented. But I never think about disk fragmentation with this
server. It still runs as fast as it did when I put it together. Okay,
that is not very fast because the machine is almost ten years old.
But that does not have anything to do with the filesystem.

If you are still very worried about filesystem performance,
choose ReiserFS when you install Linux. ReiserFS is fast. But, if
you did not choose ReiserFS, it should not matter. You should
not have to defrag your disks.

Linux has a program like scandisk, but you should not have
to use it. All the modern versions of Linux use what is called a
journaling filesystem. You say you are using Fedora Core 5, so I
think you are using the ext3 journaling filesystem. Linux will
check the filesystem every time you boot Fedora Core 5. If you
do something silly, like turn off your computer before you shut
down Linux, you may lose data that you did not save. But it
does not make Linux check the disk for a long time, because
journaling filesystems make it easy to put the filesystem back to
normal after you do something silly. Just remember that all it
does is put the filesystem back to normal. It does not bring back
the lost data.

You can set ext3 so that it will also protect your data so that
you do not lose data when you do something silly. I do not rec-
ommend this for most people. This slows down your computer
performance a lot. It is better to remember to save your files
and not do something silly like turn off your computer without
shutting down Linux. It is also good to get an uninterruptable
power supply so that you can save data when you lose power.

Can you corrupt your filesystem? Yes, but it does not happen
very often. Most of the time you boot the install CD or DVD disk
or a CD or DVD recovery disk. Then you follow instructions on
how to restore your filesystem to normal. You can go to a

command line after you boot from the CD or DVD and type a
command like fsck.ext3 /dev/sda1. I say “like” this command,
because I am guessing your filesystem is ext3, and I make up
a disk partition for you and call it /dev/sda1. Your corrupt disk
partition could be /dev/hda1 or /dev/sdb3. I do not know. You
figure this out.

The only thing I can tell you to do to keep your system
purring is to leave it on. Log off when you are done, but leave
your computer running. Linux is not Windows. You do not need
to reboot it to keep it running stable. So leave it on.

Why? Well, you do not have to leave it on, but here is
why I think you should. Linux automatically runs some main-
tenance programs on a schedule. These programs do things
like compress and rotate log files so they do not take up too
much space on your disk. Another program searches your
disk for every file and puts the information from the files in
a database. This makes it easy to find a file on your disk very
fast. Some of these programs make your computer busy, so
they will slow down your computer if they run while you are
doing work. That is why it is better if you let these programs
run in the middle of the night when they are usually sched-
uled to run. If you turn off your computer when you are
done working, these programs may decide to start running
the next time you turn on your computer. So your computer
may be slow and you will not know why. If this happens, I
can tell you that you will notice that your computer gets fast
again after maybe 10–20 minutes. That is usually the
longest it takes for these programs to finish.

Q Dear Mango, I have recently installed Kubuntu and am
in the process of installing various applications. I have

successfully installed Picasa on a 32-bit version of Kubuntu, but
I am having trouble installing it with a 64-bit version. I installed
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the ia32-libs and am still having no success. Your help would be
greatly appreciated.—Brandon

A Dear Brandon, Picasa is a very nice program to find
and manage photos and pictures and edit them. It is a

Windows program. The Linux version of Picasa is a Windows
program too. Okay, it is not 100% Windows, but it uses WINE
(and Mozilla) to work. WINE is a set of libraries to make Win32
programs work on Linux. Do you see the number in Win32? It 
is 32. It is not 64. That is your problem.

Maybe someday Kubuntu will make it easy to install WINE
on the 64-bit Kubuntu Linux. I do not know. It is not easy
now. There are two ways to make WINE work on 64-bit
Kubuntu. You can run WINE (and Picasa) in a 32-bit chroot
environment. Do you know what a 32-bit chroot environment
is? If you do not, I do not think this is a good idea. It is not
easy to make a 32-bit chroot environment work. It is like
installing most of 32-bit Kubuntu on top of 64-bit Kubuntu, so
it takes a lot of disk space and you end up with two operating
systems. Some people like this. Some people do not. It is not
easy for a desktop user to make this work. If you think you
want to try this, here is a link for running 32-bit programs in a
chroot environment on 64-bit Linux: http://ubuntuforums.org/
showthread.php?t=24575&highlight=32+bit+chroot.

You can try to compile WINE on 64-bit Linux too. I do not
know if this will make Picasa work, but it is possible. I say again
that I do not think this is a good idea for a desktop user. It is
not easy to do. But if you are geeky and think you can try it,
here is a link with instructions on how to get WINE on 64-bit
Linux: http://wiki.winehq.org/WineOn64bit.

I think the easiest way to use Picasa is to run it on 32-bit
Kubuntu. This version of Kubuntu runs well on AMD64 
computers. I do not see a big difference between the AMD64

version of Kubuntu and 32-bit Kubuntu. The 64-bit version is
faster when you do some special things like encode videos and
music—if you do that often. I do not do that often, so I am
happy with the 32-bit version on my AMD64 computer.

Q Dear Mango, my network connection stopped working
on Linux and I can’t find the problem. It used to work

and now it doesn’t. I know the integrated network card is 
not broken because I dual-boot to Windows and it works in
Windows.—Name Withheld

A Dear Name, I almost chose not to answer your question
because you give me very little information. But you say

one thing that may be a clue. Did you install Linux first and then
install Windows? Maybe your network connection works fine
with Linux until you start using Windows. Am I wrong? I think
I am the opposite.

I know there are some integrated network cards on mother-
boards with NVIDIA Nforce chips that stop working in Linux after
you use Windows. I do not know if this is a Windows driver
problem or a Linux driver problem. Maybe the Windows driver
changes how the card works and when you boot Linux it does
not know how to reset the card. Maybe it is the Linux driver
that makes a mistake after the Windows driver uses the card.
I do not know. Maybe someday the Linux kernel developers will
find out how to make this problem go away.

Here is how you can find out if this is your problem. Turn
off your power supply. I do not mean turn off the computer.
I mean use the button that is on your power supply. If your
power supply does not have a button, then unplug your
computer. Wait 15 seconds or maybe 30 seconds. Now plug
in the power again or turn on your power supply. Turn on
the computer and boot to Linux. Do not boot Windows first.
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Go to Linux first. Does your network connection work
again? If your network is working again, you know
Windows is making it stop working.

If you find out that Windows is making the network stop
working for Linux, I have three answers for you. Stop using
Windows. Turn off the power supply or unplug your computer
after you use Windows. Wait for the kernel developers to fix or
work around this problem. Keep updating your Linux distribu-
tion and hope your Linux distribution upgrades to a new kernel
with a fix or workaround.

Q Mango, I have a problem and hope you can help. I
updated two different Kubuntu Breezy boxes and had

two completely different outcomes. At work, I run an Intel
Mobo with a P4 2.4 built-in everything. Upgrading to Dapper
worked just fine. At home, I run an ASUS AMD 1500+ ATI
RADEON 9550 (which was not easy to get working correctly).
I updated them both by changing the repositories to point to
dapper instead of breezy in synaptic and then marked all
upgrades and applied. At home, X does not come up. It says
there is no display. Do I go through reconfiguring Xorg? or
should I install Dapper from a CD?—Rob

A Dear Rob, you say that it is not easy to get the ATI
RADEON 9550 working. I am guessing this is because

you are using the ATI proprietary drivers. Am I wrong? Here
is where I think you get the drivers: https://support.ati.com/
ics/support/KBAnswer.asp?questionID=1176.

When I look, I see the ATI drivers work with Xorg X11
6.8. Dapper uses Xorg 7.0. Do you think maybe this is the
problem? If this is the problem, you need to change your
Xorg configuration to stop using the ATI proprietary drivers
and use Xorg drivers instead.

Q First of all, great magazine. I happened upon TUX just two
issues ago, and I’ve been checking out back issues and

waiting on the new ones ever since.
I’d like to know what programming language you would

recommend for someone who is interested in getting started,
and also what IDE to use on the Linux platform. I realize that
an opinion on the “best language” most likely depends on the
target use, but I’d be interested to know your answer to the “I’d
like to learn to program, where should I start?” question. As far
as IDEs go, I know the whole Emacs vs. Vim is a flame war wait-
ing to happen, but I’ve seen many other IDEs out there, and I was
wondering if a newbie might fare better by trying one of those
instead.—Scott

A Dear Scott, I laugh at this letter because it is like asking,
“what is the best Linux distribution?” I have to read your

mind to find the best answer, and although I am a humble
genius, I cannot read minds. But I will tell you some ideas.

If you want to be a serious programmer someday, learn C.
C is not the best language. I do not recommend C because it is
better than another language. I recommend C because it makes
you learn about things like pointers and syntax. If you learn how
to make these things work in C, it will be easy for you to learn
almost any other language after you know C.

There is one thing C does not teach you. It does not
teach you how object-oriented languages work. If you think
you want to learn about object-oriented languages, I think
you can start with Python or Ruby. Do you notice that I do not
say C++ or Java? C++ and Java are like each other in many
ways, and they are both good object-oriented languages. 
If you get serious about programming, you want to learn
C++ and Java. But I think it is easier to learn about object-
oriented programming from Python and Ruby than C++ or

P2P

19www.tuxmagazine.com

https://support.ati.com/ics/support/KBAnswer.asp?questionID=1176
http://www.tuxmagazine.com


Java. So I tell you to start with Python or Ruby.
KDevelop (for KDE) and Eclipse are the two best IDEs. Try

them both and see if you like them. Many programmers use text
editors not IDEs. If you want to try just using text editors, there
are too many to suggest. I like Kate (KDE), Cream (a customized
configuration for vi), Jedit, J and Jext (three Java-based editors)
and some console editors too.

Try an IDE called Idle, if you want to play with Python in
interactive mode. Do you have Java installed? Try Jext from
http://www.jext.org. Nobody is maintaining Jext anymore, but
it is a good editor and it lets you run Python scripts.

These are my ideas. If someone reads my ideas and is thinking,
“she should have said Perl or Bash or my favorite language or
editor”, I want you to know I do not care about your favorite
languages or your favorite editors or your favorite IDEs. If Scott
wants to know about your favorite things then he should write
to you and ask. He did not write to you. He wrote to me. So
keep using your favorite things and do not yell at me for not
having the same favorites as you do.

MANGO ASKS QUESTIONS
Here are two important letters I get. They are similar letters
because they are about SATA drives. Mr George and Mr
Daniel, you do not give me enough information to know
what problems you are having. I do not usually ask ques-
tions about questions, but I think because I get so many 
letters about SATA drives, maybe it is time to do something
different. So I ask Mr George, what are the drives you cannot
use? The IDE drives? The SATA drives? To Mr Daniel, what
kind of system are you using with SATA? Do you know what
kind of motherboard it is or what kind of SATA chip it uses?
Are you installing Debian from a SATA CD/DVD drive? I 
hope you will write back to me with more details. Maybe 

I can write up answers for both of you and for other people
with SATA problems.

Q Dear Mango Parfait, I have three hard drives on my system:
one I use for programs, one for data and one for backup

purposes. I save images of the other two in it. The first two are
SATA drives (they used to be SCSI drives, but I changed them to
SATA), and the last one is as IDE drive. Every time I try a Linux
distribution (and I have tried several), I have problems getting to
my other drives. MEPIS does show that I have them, but I can’t
do anything on them. I tried resetting permissions on them but to
no avail. All the other distributions don’t even show that I have
them. I guess that their presence is noted in a directory some-
where, but how to get to them is a mystery.

Anyway, I was wondering if you could show me how to 
get these hard drives on the desktop and actually be able 
to use them in a distribution such as SUSE 10 or Debian?
—George Emerson

Q Hi, Mango, there are issues these days while trying to
install Linux on a full SATA configuration. A couple of

days ago, I read that actually the latest versions for distros like
Debian, Mandriva and so on would allow installation on such a
configuration without the well-known workarounds.

I tried it with Debian, and it did not work. I got the message,
“did not find any partitionable media” and so forth.

Do you have any idea of how to install such a configuration
without workarounds like “legacy mode” and so on?—Daniel �

I am a sweet, humble, delicate and very cute genius who is at your service to
answer your Linux questions. Send your questions to mango@tuxmagazine.com.
I am deeply sorry that I do not have time to respond to anyone directly by
e-mail, but I will select as many questions as I can and answer them here.

P2P
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Although for many the OpenOffice.org Base
application is an obvious choice for building a
desktop database application, it’s not the only
game in town. Kexi (http://www.kexi-project.org),
a relatively new member of the KOffice family,
allows you to create simple databases without learn-
ing all the intricacies of database development.

HOW A DATABASE WORKS
Although you don’t have to be a database guru to
create databases with Kexi, you must have some
basic knowledge of how databases work. This will
help you not only to build better applications, but
also will save you from spending hours fixing
poorly designed databases.

Like any database system worth its salt, Kexi
consists of three essential components: tables,
queries and forms.

� Data within a database is stored in tables.
Each table consists of rows and columns,
and the data contained in one row is known
as a record.

� Queries are used to extract, view and manipu-
late data. Queries can draw together data from
many tables, and they also can have forms and
reports based upon the data they produce.

� Forms allow you to view and edit the data in a

table. You can think of forms as a GUI for the
database; although tables are used to store
data, forms are used to display and manipulate
data in the table.

You can say that a database consists of three
layers. At the bottom layer are the tables where
the data is stored. Above the tables are the
queries that extract and manipulate the data in
the tables. And, finally, there are the forms that
are based on the queries or directly on the tables.

INSTALLING KEXI
Of course, before you can do anything useful
with Kexi, you have to install it. As with any Linux
application, you have several options here. If
you’re using a mainstream Linux distribution, you
can install Kexi using your system’s package man-
ager. If Kexi is not available with your distribution,
you can 1) download a package for your system
from Kexi’s Web site, 2) install Kexi using klik
(http://kexi.klik.atekon.de), or 3) try Kexi using
one of the many Live CD distributions, such as
KNOPPIX or KANOTIX. Of course, you always
can download the source code and compile it
on your machine.

GETTING STARTED WITH KEXI
Once Kexi is installed, launch it and choose Blank
Database from the Choose Project dialog window.

In the Creating New Project dialog window, select
New Project Stored in File. This creates a database,
where everything is stored in one file on your hard
disk. Give the new database a name, and choose
where you want to save it. A new blank database
is now ready, but before you start working on it,
let’s take a closer look at Kexi’s interface.

Figure 1. Kexi lets you create databases that are
stored either locally or on a remote server.

The main window in Kexi is divided into three
main areas (Figure 2). To the left, is the Project
Navigator pane that contains database compo-
nents, such as tables, queries and forms. To the
right, is the Properties pane that allows you to
define different properties for the currently selected

BBuuiillddiinngg  aa  DDaattaabbaassee  wwiitthh  KKeexxii
Billed as the open-source competitor to Microsoft Access, Kexi provides a rapid application development tool for database systems.

DMITRI POPOV
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element. Finally, in the middle, is the working
area, where you actually build your database.

Note: you can undock both the Project
Navigator and Properties Editor panes, which can
come in handy when you are working on a com-
plex database and you want to free more space in
the working area (Figure 3). To undock the pane,
click on the tiny Detach arrow; to dock it back,
click on the Dock arrow.

For this project, let’s build a simple database to
use for keeping track of computer equipment in
your company or home. Start with deciding what
kind of data you want the database to store.
Obviously, you’ll want to keep track of the type of
hardware (laptops, printers, routers and so forth),
model, serial number, purchase date and so on.

This means the table
should contain fields like
product for product type,
maker for brand, model
for model name, serialno
for serial number, pur-
chased for purchase 
date and notes for any
additional information.
Also, it’s a good idea to
have a unique identifier
for each row in the table,
which in database parl-
ance is called a primary
key. The primary key
helps not only to identify
each record in the data-
base uniquely, but it also
plays a crucial role in
creating relationships
between tables in more
complex databases.

Now you are ready to add a table to your data-
base. Left-click on the Tables icon in the Project
Navigator, and select Create Object: Table. Switch
to the Design View mode by pressing F7. Click on
the first row in the Field caption column, and type
id. From the Data type list, select Integer Number,
and add an optional description in the Comments
column. The id field is going to be the primary
key, so set the Primary Key property in the
Properties pane to Yes. This also sets other
primary key properties—Unique, Required,
Autonumber and Indexed—to Yes. Now, add the
rest of the fields and their appropriate data types
to the table as shown in Figure 4. Press the Save
button to save the table, and give it a name, for
example, hardware. To populate the table with

HOME PLATE
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Figure 2. Kexi’s Three-Pane Interface

Figure 3. You can undock the Properties Editor
window to free space in the working area.

http://www.tuxmagazine.com


records, switch to the Data View mode and add a
few rows of data.

The next step is to add a form that will act as
the user interface for the database. To create a
blank form, left-click on the Forms item in the
Project Navigator and select Create Object: Form.
This creates a blank form. First, you have to
“connect” the form to the table, so you can use
the form to view, add and modify data from this
particular table. Click anywhere in the form, then
click on the Data sources tab in the Properties
pane (the tab in the middle), and select the
hardware table from the Form’s data source
drop-down list.

Now, if you take a look at the main toolbar, and
you will notice some additional buttons. These but-

tons let you add so-called
widgets to the form. The
widgets include text
boxes, check boxes, radio
buttons and different
design elements. Let’s
start with adding text
boxes to the form. Make
sure that you are in the
Design View mode (press
F7), click on the Text Box
button on the main tool-
bar, and draw a text box
in the form. Next, con-
nect the text box with
the appropriate field in
the table. Click on the
Data sources tab in the
Properties pane, and
select the product field
from the Source field
drop-down list. Switch to

the Properties tab, and configure the text box’s
properties. At the very least, you might want to
give the text box a more descriptive name, so you
can locate it easily in the form using the Widgets
tab in the Properties pane. Save the form, and give
it a name, for example hardwareform. To see
whether the form works properly, switch to the
Data View mode by pressing F6. The text box
should display the contents of the product field
in the hardware database. If for some reason the
text box is empty, try to use the Previous and Next
navigation buttons at the bottom of the form to
browse through the records. If everything works as
it is should, return to the Design View mode, and
add the rest of the fields. You also can add some
design elements, such as field labels, headers,

HOME PLATE
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Figure 4. The Finished Table

Figure 5. Use the Data sources tab to “connect”
the form to the table.
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images and so on, to spice up the form a bit.
Your very first Kexi database is almost ready,

but the introduction to database development
won’t be complete without taking at least a brief
look at queries. Let’s say you have several laptops,
and you want to locate their info in the table
quickly. You can, of course, use the search fea-
ture, but you also can create a simple query that
allows you to find all laptops with a single mouse
click. To create a query, left-click on the Queries
item in the Project Navigator pane and select
Create Object: Query. Switch to the Design View
mode by pressing F7. In the working area, select
hardware table from the Table drop-down list,

and press the Add button to add the table to the
query. Now, drag the fields you want onto the
Columns part of the Query Columns window. Set
the Criteria of the product row to Laptop. The
final query should look like the one shown in
Figure 7. Save the query, and give it a name, for
example, findlaptops. Switch to the Data View
mode to see the results of the query. That’s it—
your first Kexi database is ready to go.

FINAL WORD
Thanks to Kexi, creating a database doesn’t
have to be complicated. Better yet, knowing
the basics of database design, you easily can

apply your skills to other database manage-
ment applications, such as OpenOffice.org
Base, Knoda, Rekall and many others. And, if
you want to know how Kexi stacks up against
other database systems, check the following
page: http://kexi-project.org/wiki/wikiview/
index.php?KexiComparisons.�

Dmitri Popov is a freelance writer whose
articles have appeared in Russian, British
and Danish computer magazines. His
articles cover open-source software,
Linux, Web applications and other
computer-related topics.

HOME PLATE

24www.tuxmagazine.com

Figure 6. Adding Widgets to the Form Figure 7. The Finished SQL Query
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At the office, I have the great privilege of choos-
ing the operating system for the laptop provided
to me by the company. I have, of course, chosen
Linux, with the specific distribution being Fedora
Core 5. Linux generally increases my productivity.
One area that has been cumbersome, in the past,
has been e-mail/collaboration.

My place of employment uses Microsoft
Exchange, and until recently, I was able to use
Evolution only to check my e-mail. With the open-
sourcing of the Exchange Connector for Evolution,
I am now able to use the calendaring features
also, and if I chose, the Global Address Book of
the Exchange server.

Being able to use the calendar was a must, as I
am a forgetful person. The reminders of the many
meetings are a must. In addition, my supervisor
loves to assign me tasks via the Exchange server. I
can no longer claim the inability to retrieve these
tasks from my Linux machine as an excuse for
ignoring his task list.

All modern Linux distributions come with
Evolution as the primary mail client by default.
Some, however, do not install the connector piece
necessary to connect Evolution to a Microsoft
Exchange server automatically.

This article is an outline of how to install the
Exchange Connector under Fedora Core 5. As
each Linux Distribution has its own package
manager, the process will vary from distribution

to distribution. Before getting started, you should
ask your Microsoft Exchange administrator for
the Outlook Web Access URL. You also will
want to make note of the domain for which
your Exchange Server is configured for
Windows authentication.

To begin, open the Add/Remove Software
application by clicking the Application Menu and
choosing the Add/Remove Software menu option.
Figure 1 displays a screenshot of how this looks
on my system.

Once the Add/Remove Software application
has launched, you must provide the root user’s
password, as software management is considered
a system administration task. With the application
launched, click the Search button located on the
left side of the screen. In the search field, type
evolution. You may see many results, most of
which are irrelevant to what we are trying to
accomplish here. From the list, select evolution-
connector by clicking the check box next to the
item. Notice the version number next to the soft-
ware description. You need to be sure to select
the version number that most closely matches the
version of Evolution you have installed. Because
you searched on Evolution, you should be able to
view the Evolution version number in the same
search window.

With the item selected, click the Apply button.
The Add/Remove Software application then

presents you with a summary of the actions to be
taken, namely the installation of the Evolution
Connector. Proceed by clicking the Continue but-
ton. The evolution-connector is now downloaded
and installed on your system.

With the Apply button clicked, the Software
Manager downloads the evolution-connector
software in the form of an RPM and proceeds by
installing the software. See Figure 2 for an illustration.

CCoonnnneeccttiinngg  EEvvoolluuttiioonn  ttoo  MMSS  EExxcchhaannggee
With the Exchange Connector, you can use Evolution to connect with a Microsoft Exchange mail server and use all of the messaging and calendaring functions available.

DANIEL MCCARTHY
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With the required software now installed, it is
time to launch Evolution! For the purposes of this
article, I assume this will be the first run of
Evolution. On the first run, Evolution walks you
through the steps necessary to configure an 
e-mail account. The first screen presented is a
summary screen that informs the user of the 
configuration that is about to take place.

The second screen presented allows you to
enter the e-mail address for the account you are
going to set up, as well as your full name.
Following this screen, you are presented with the
server type configuration. We choose Microsoft
Exchange from the drop-down menu. With the
correct server type selected, two additional fields
appear: one for the Microsoft Exchange user
name and one for the Outlook Web Access
(OWA) URL.

An important note here: when I use OWA, the
URL should not be a Secure Sockets Link (SSL)
URL—meaning do not use a URL that begins with
https, instead use one beginning with http. The

https option uses forms-based authentication, and
the http option uses HTTP authentication. I have
had success only using HTTP authentication.
Notice the URL in Figure 3.

I’ve found that many people do not realize
they are logging on to a domain when working in
Windows and consequently when accessing OWA.
The domain portion of a user’s login credentials
may be hidden by making use of a default
domain. In the user name field in Figure 3, 
you will notice “compopt” followed by a 
backslash, followed by my actual user name.
The compopt portion is the domain I am a part
of. The backslash is simply a separator for the
domain and user name.

At this point, you are required to test the
connectivity to Exchange by clicking the

Authenticate Button. Clicking this button pres-
ents a dialog requesting your password. Enter
your password, and click the Ok button. This
tests the URL and user name provided to
ensure that Evolution is able to communicate
with Exchange. Determining whether there is a
problem in the entry of the user name or OWA
URL early on usually saves headaches in the
future. If authentication succeeds without any
error messages, you can proceed by clicking
the Next button.

The next screen presented lets you configure
various options, such as server side filtering,
how Evolution checks for new messages, junk
mail settings and so forth. I have noticed that
checking the Apply filters to new messages in
Inbox on this server option noticeably slows

SUITED UP
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Figure 3. Receiving Mail Options Figure 4. More Receiving Options

Figure 2. Add/Remove Software Search
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Evolution down. Figure 4 provides an illustra-
tion of the receiving options available. After
choosing a name for the account you have just
set up and selecting the appropriate time zone,
you are done!

Setup is done, but the waiting is not over. 
I have roughly 2,500 messages waiting for me
on Exchange. The first time Evolution connects
to Exchange to download these messages the
process is incredibly slow; however, things tend
to speed up a bit after the first run.

When the Exchange account is added,
Evolution automatically adds the Calendar from
your account. For me, being able to access my
Exchange calendar while working within Linux is
the best feature of the connector. I am able to
receive reminders and accept meeting invitations
all within Evolution. Although I now receive the
reminders, I don’t always pay them any mind, as
you might notice from Figure 5.

Speed is one of the two complaints I do have
with the functionality. As mentioned previously,

the initial download of e-mail messages is hugely
time consuming if you have a large number of
messages. During this time, Evolution may
appear to stop responding. I recommend
patience. Evolution will come back. Second in
the list of complaints is speed. When Evolution
drags during the download of the e-mail messages,
I have inadvertently caused it to crash. Sometimes
when this happens, I simply can re-open Evolution
and continue; other times it appears that some
back-end Evolution process has stopped working.
Having not taken the time to discover how to
restart this process manually, I often do the usual
Windows fix and reboot.

While writing this article, I endeavored to
explore a little deeper into the functionality I
thought missing. One of the areas I discovered
support for upon the conclusion of writing this
article is shared calendars. At my office, we have
a company-wide calendar where vacations,
client visits and the like are placed. With a little
RTFM and a little bit of help from Google, I have
discovered that switching to the Calendar view
and then selecting File→Subscribe to Other
User’s Calendar enables me to do this. I am
working with our Exchange administrator now
to make sure our Global Catalog Server is set up
so that I can make use of this feature. Overall,
the Evolution Exchange Connector has greatly
improved my productivity—or at the very least,
increased my ability to be productive.�

Daniel McCarthy works by day as a configuration manager for
Computing Options Company developing software in both
Java and PHP. By night, he works as the system administrator
for http://techguy.org. He is an avid Linux enthusiast and
promoter of open-source software.
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One of the potentially most influential categories
of software applications for introducing Linux into
an enterprise is virtualization. With a virtual
machine, you can remain compliant with many
strict information technology department guide-
lines and still run Linux. Even if those guidelines
stipulate that all desktop computers must run
Microsoft Windows, you still can comply by
installing a virtual machine on top of Windows and
then installing the Linux flavor of your choice within
the virtual machine. In this review/tutorial, we
show you where to get software free of charge
that will give you the tools necessary to download
prebuilt virtual machines and then run Linux.

This is a review and a tutorial rolled into one.
First, this article introduces the VMware Player
and explores its capabilities. The review part of the 
article also explains the tools you’ll need to get the
most of the VMware Player. Second, because this
issue targets Linux in the enterprise, we thought it
would be useful to show you how to run Linux on
top of Windows. As a clever way to introduce Linux
into the enterprise, virtual machines provide great
flexibility while delivering superior performance.

VMWARE PLAYER
First, within the last 18–24 months, VMware, Inc.,
has risen to the top of the industry by providing a

wide variety of virtualization choices. These choices
include two freely available virtual machines:
VMware Player and VMware Server. The focus of
this article is the VMware Player.

Before diving into the review, we need to make
something perfectly clear. Although part of this
article covers how to install VMware player in
Microsoft Windows, VMware Player is also avail-
able for Linux. And, for us, there is very little dif-
ference between the two versions. The installation
experience is nearly the same, and the functionality
is the same as well. So, everything covered in this
article is equally true for Linux. Never thought of
trying virtualization to obtain Linux? Why bother?
Here are a couple reasons to consider:

� Testing: first and foremost, virtualization has
opened up many options by allowing users
to create an exact mirror copy of their pro-
duction configuration and test the impact 
of installing new packages and software.
Further, if you’re not sure which Linux distri-
bution you want to try, there are about 40
different options just in the Operating
Systems category of the VMware Technology
Network. Try one, or try them all. And, if you
don’t find the distribution you’re looking for,
I bet it’ll be available soon.

� Secure browsing: through the use of a Browser
Appliance, available at http://www.vmware.com/
vmtn/appliances/directory/browserapp.html, you
instantly can make any computer highly secure
for completing on-line transactions, such as
purchases and bank transfers.

Finally, if you think your IT department won’t
let you install VMware Player, go ahead and ask.
Most likely, the systems administrators are already
using a VMware product inside the server room,
so maybe they’ll understand that it is safe. If not,
make sure they know that installing software
within a virtual machine is the safest way of all to
operate, because the virtual machine creates a
barrier between the the virtual machine and the
host operating system, so there is no way to
damage the underlying system.

INSTALLATION
The steps necessary to install VMware Player within
Microsoft Windows are simple. Simply download
VMware Player from http://www.vmware.com/
products/player, and double-click the file when the
download is complete. Once again, the Linux
installation is equally as easy. We give VMware
Player an excellent rating for installation.

EASE OF USE
Because most of the action goes on within the
virtual machine, that means the application itself is
quite easy to use. For example, after the installation
is complete, all that is necessary to launch a virtual
machine is to double-click a *.vmx file. (When
speaking of virtual machines in conjunction with
VMware, they are referred to as virtual appliances.)
This starts the VMware application using the virtual

UUssiinngg  VVMMwwaarree  PPllaayyeerr  ttoo  IInnttrroodduuccee
LLiinnuuxx  iinnttoo  tthhee  EEnntteerrpprriissee
Virtualization opens new Linux users to a fresh approach to obtain, assess and hopefully adopt Linux.

KEVIN SHOCKEY
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machine defined in the *.vmx file.
It can get a little confusing switching between

the virtual machine and the host computer, but
with a little practice it becomes second nature. To
capture the input for the virtual machine, press
Ctrl-G. To return control to the host computer
press Ctrl-Alt.

DOCUMENTATION
Six different sources of documentation are
available for VMware Player. On the VMware
Technology Network (VMTN) are the release
notes for the current version of the VMware
Player, the VMware Player Manual, Guest
Operating System Installation Guide and the
Virtual Machine Mobility Planning Guide. In
addition, when you download the prebuilt
Browser Appliance, it comes with its own

Browser Appliance Getting Started Guide.
Finally, the VMware Player itself comes with
embedded help files as well.

Although the VMware Player is simple to use,
having this documentation available should ease
the most inexperienced user’s task of learning
how to use virtual machines. We give the 
documentation a good rating.

CAPABILITY
In this section, we analyze whether the VMware
Player fulfills its primary function—virtualization. In
the months we have been using the Player, it has
continued to impress us. With the ever-growing
list of virtual appliances provided at the VMware
Technology Network, obtaining the leading-edge
Linux distributions is only a few clicks away.

Now, some might worry that because VMware
Player is such a cutting-edge prod-
uct, it might require cutting-edge
hardware to accomplish its task. You
might be surprised to find the
requirements rather modest:

� Processor speed: 400MHz 
or faster (500MHz or faster 
recommended).

� Memory: 128MB minimum,
256MB recommended. You must
have enough memory to run the
host operating system, plus the
memory required for each guest
operating system and for applica-
tions on the host and guest.

� Hard disk: at least 1GB free disk
space for each guest operating 

system. For installation, VMware Player requires
approximately 150MB.

In terms of host operating systems, although it
supports a wide range of options, to install
VMware Player on a Windows machine, you must
have Windows XP or Windows 2000. All major
Linux distributions can serve as hosts. So although
the requirements aren’t bare-bones, I would be
surprised to find many machines capable of running
Windows XP that can’t run VMware Player.

Two especially handy features are worth
mentioning. First, once you have a virtual 
appliance installed and in working order, you
can make a copy of that virtual appliance, just
in case something goes horribly wrong while
testing. To do this, make sure your virtual
machine is not active, and simply copy the
directory where it is installed. To restore your
working virtual appliance, copy the backup
back into your virtual appliance directory, and
everything will be restored back the way it was.

The other great feature is the ability to suspend
any virtual appliance by simply exiting the applica-
tion. Make sure you set the preferences of the
VMware Player to suspend the virtual machine
when exiting.

For being able to do everything that one might
expect from a virtual machine, we give the
VMware Player an excellent rating in capability.

COMPATIBILITY (WHICH AND HOW MANY
DISTRIBUTIONS WORK WITH VMWARE)
VMware Player supports a wide range of both
host and guest operating systems. Nearly every
major Linux distribution is supported as both a
host and a guest. Definitely, it deserves an excel-
lent rating for compatibility.

SUITED UP
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CHEAT SHEET FOR PRODUCTS AND CAPABILITIES

VMware Player: can play only virtual appliances. It can use 
a Linux Live CD virtual appliance to boot CD images.

VMware Workstation: can create and play virtual appliances.

You can author your own virtual appliances here:
http://www.consolevision.com/members/dcgrendel/vmxform.html.

Another, easier, Web site for creating virtual appliances:
http://www.easyvmx.com.

Note: on April 3, 2006, VMware announced the 
Open Virtual Machine Disk Format Specification
(http://www.vmware.com/news/releases/vmdk.html). This
announcement made the Web sites listed above possible.

http://www.consolevision.com/members/dcgrendel/vmxform.html
http://www.easyvmx.com
http://www.vmware.com/news/releases/vmdk.html
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SUPPORT
Because VMware Player is available free of
charge, the amount of support available is 
limited. There is the product documentation,
the included help information, a Frequently
Asked Questions (FAQ), a discussion forum and
a knowledge base. Out of curiosity, we looked
up a question we had and quickly found an
answer in the VMware Player Forums. We rate
the support for VMware Player average.

PRICE
It’s hard to beat software of this quality that is
available without charge. Plus, if you consider that
VMware made the file formats for its virtual appli-
ances available to the Free Software community,
the price is even better. This lets you use publicly

available Web sites to generate your own blank
virtual appliances. These are suitable for installing
the operating systems of your choice. Our rating is
excellent for price.

HOW TO RUN LINUX ON A COMPUTER 
RUNNING MICROSOFT WINDOWS
Now that we’ve reviewed the VMware Player, let’s
get Linux installed on a host Microsoft Windows XP
computer. For the purpose of this tutorial, let’s
assume that you’ve gotten permission from your
Information Technology department to install a
secure Browser Appliance to prevent your computer
from being infected by viruses, spyware, adware or
malware. So, let’s install the VMware Player and the
Browser Appliance, and within a matter of minutes,
you’ll be safely browsing the Web in your very own
Ubuntu Linux and Firefox virtual machine.

INSTALLING THE VIRTUAL MACHINE
Navigate over to the VMware Player Web page
(http://www.vmware.com/download/player), and
download the Player. It is approximately 29MB, so if
you have a broadband connection, it shouldn’t take
too long. Once the download is complete, double-
click on the VMware-player-x.x.x-nnnnn.exe file (the
x.x.x corresponds to the version number, and the
nnnnn corresponds to the build number).

After starting the installation, click the Next but-
ton to continue the installation. The next dialog is
the VMware Player license; please read it carefully.
The VMware Player is not licensed as open source.
You many not redistribute it freely. If you agree,
click the agree radio button, and click the Next but-
ton. The next dialog prompts for the installation
directory. Change the directory, if desired, and click
the Next button. Now you need to select the instal-
lation shortcut options. Select your preferences for

whether the instal-
lation should install
a shortcut on the
Desktop, in the
Start Menu
Programs Folder or
in the Quick
Launch Toolbar.

The next step in
the installation
process requires
you to set your
VMware configu-
ration options. 
We recommend
staying with the
defaults. Click the
Next button to
advance the instal-
lation. Once you click Next, the installation routine
has everything required for the installation and
the installation begins.
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Figure 1. Suspend Preference in VMware Player
Preferences

SUMMARY

INSTALLATION: excellent

EASE OF USE: excellent

DOCUMENTATION: good

CAPABILITY: excellent

COMPATIBILITY: excellent

SUPPORT: average

PRICE: excellent

OVERALL RATING: excellent

Figure 2. Initiating the VMware Player Installation

http://www.vmware.com/download/player
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When the installation is complete, the instal-
lation routine presents a successful installation
dialog. Click the Finish button to conclude the
installation. Now that the VMware Player is
installed, we can obtain a virtual appliance

from the VMware Technology Network.
As I prefaced this tutorial, our objective is to

install a secure browser capability. Therefore,
we need to download the Browser Appliance
from the VMTN Virtual Appliances, available
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Figure 3. VMware Player Installation Options Figure 5. VMware Player Installation In Progress

Figure 4. VMware Player Configuration Options Figure 6. Successful VMware Player Installation

Figure 7. Selecting the Extraction Directory for the
Browser Appliance

Figure 8. Extraction Complete
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at http://www.vmware.com/vmtn/appliances/
browserapp.html. This file is significantly larger at
258MB zipped, but at least there is a BitTorrent

download available. Once you’ve downloaded the
Browser Appliance successfully, extract the files
from the compressed file. Right-click on the file,
and select Extract All to start the extraction wizard.
Click the Next button, and select the destination
folder for the virtual appliance, and click the Next
button again. The extraction process requires
approximately 962MB of space decompressed.

When the extraction process is complete, the
Extraction Wizard displays the Extraction
Complete screen. Leave the Show extracted files
option selected, and then click the Finish button.
When the directory with the virtual appliance
appears, locate the Browser-Appliance.vmx file
and double-click on the file. This launches the
Browser Appliance. First, the VMware Player ini-
tializes the virtual machine, and then the Ubuntu
boot process begins.

Following a successful boot, the next thing that
should appear is Firefox. Congratulations—you’re
now running Linux within your enterprise. Although

this is a stripped-down installation of Ubuntu, you
can start adding applications with Synaptic Package
Manager or simply use this bare-bones installation to
learn more about Linux and enjoy secure browsing.

CONCLUSION
The combination of VMware Player and the many
different virtual appliances available in the VMware
Technology Network provide a wide variety of
options for trying Linux. If you’re cramped for space,
try the Puppy Linux virtual appliance. Puppy Linux
1.0.7 is very small, reliable, easy to use and fully 
featured; it’s 62MB zipped and 167MB unzipped.
Although I would prefer that VMware Player was
free or open source, the company has been very
accommodating to the community. Other virtualiza-
tion tools are free or open source, but I don’t
believe any deliver the same level of sophistication,
maturity and ease of use as VMware Player. Let’s
hope, however, that the example set by VMware
and its leadership in virtualization bring equal
advances in free and open-source alternatives.�

Kevin Shockey is Editor in Chief of TUX.
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Figure 9. VMware Virtual Machine Initialization

Figure 10. Ubuntu Linux Boot-Up Process within
VMware Player

Figure 11. Firefox Running on Ubuntu within the
VMware Player

EDITOR’S NOTE
Getting Linux into the enterprise and onto
more desktops is essential. More than anything,
we need to build more Linux awareness and
skills across all enterprises. If installing Linux
via a virtual machine is the first step to enable
that building process, it is worthwhile.

http://www.vmware.com/vmtn/appliances/browserapp.html
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Creating maps is by no means an easy task. Although there are a few
open-source Geographical Information System (GIS) applications available for
Linux, they are all geared toward professional users, and as such, they have
quite a steep learning curve. Even if you manage to master a GIS application,
you still have to produce maps or find pre-made map templates, which quite
often are rather expensive. Fortunately, there is an easy-to-use software
package called OOoHG (http://ooo.hg.free.fr/ooohg/ooohg.html) that

includes everything you need to create virtually any type of map. OOoHG is
not a standalone application, but a huge collection of maps and mapping
elements stored as OpenOffice.org Gallery files. This means instead of learning
a completely new application, you can use OpenOffice.org’s familiar tools.
Better yet, the entire process of designing a map can be done via drag and
drop. However, there is one drawback. OOoHG is developed with French
users in mind, and its documentation is available only in French. But don’t
despair; this article will help you get started with this amazing map library.

OOOHG’S CONTENTS
The core of OOoHG consists of three libraries. CART’OOo is designed to
create maps and geographical drawings quickly. It consists of 189 vector-
based (vector graphics are the creation of digital images through a sequence
of commands or mathematical statements, allowing the images to enlarge
without losing quality, as opposed to bitmap graphics, which contain a bit
for each pixel and become blurry as the image is enlarged) geographical and
historical maps divided into 13 themes and 135 geographical objects that
can be used to create maps—legends, drawings and so on. The CHRON’OOo
library is designed specifically for creating chronological timelines using the
supplied objects. The third library, ATLAS’OOo, allows you to create bitmap
maps using 21 geographical and nine historical themes, which total an
impressive 413 maps.

DOWNLOADING AND INSTALLING OOOHG
To download the latest version of OOoHG, point your browser to
http://ooo.hg.free.fr/ooohg/ooohg.html, locate the OOoHG.zip file on
the page, and download it to your computer. Unpack the archive using
your favorite archiving tool; on KDE, left-click on the file and choose
Extract→Extract to ooohg/. This creates the ooohg folder containing the
unpacked files. Next, move the contents of the ooohg folder to the

OOOOooHHGG
Oui, oui. We can do maps with OOoHG and OpenOffice.org Gallery.

DMITRI POPOV

33www.tuxmagazine.com

TUX EXPLAINS

Figure 1. OOoHG is an extensive library that resides in the gallery folder
inside OpenOffice.org.

http://ooo.hg.free.fr/ooohg/ooohg.html
http://ooo.hg.free.fr/ooohg/ooohg.html
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/home/username/.openoffice.org2/user/gallery directory, where username is
your user name. Note: to access the invisible .openoffice.org2 folder, you
must enable the Show Hidden Files feature in your file browser. Once the
files are copied, launch OpenOffice.org Draw, and click on the Gallery
button, or choose Tools→Gallery. This opens the Gallery window, and if
the OOoHG library has been installed properly, you should see the OOoHG
themes in the Themes pane. By default, all the themes have French names,
but you easily can rename them: left-click on the theme you want, select
Rename and give the theme a new name.

CREATING A MAP
Now it’s time to design a map, and for this article we design a map of
Germany. In the Themes pane, select the Cartes 04 Europe Etats, and from
the gallery pane, select the Allemagne Landers map (to locate the appropri-
ate map quickly, you might want to switch to list view). Drag and drop the

map onto a blank drawing. As you may know from your geography classes,
Germany consists of several federal states (or just states), and you can see
their borders on the map. As it is, the map is pretty bare-bones, and you can
spice it up a bit by applying different colors to the states. But before you do
that, it is important to understand how OOoHG’s vector-based maps are
made. Each element on the map is drawn using Bézier curves, and once all
the elements are done, the map is assembled using the Group tool, so it acts
as a single vector drawing.

To see why this is important, let’s put some colors on the Berlin and
Brandenburg states. To modify the individual elements of the map, select
the entire map by clicking on it, then choose Tools→Enter Group (or press
F3). Now select the Berlin state, left-click on it and select Edit Points.
Alternatively, you can either choose Edit→Points or press F8. In the Edit
Points toolbar, press the Close Bézier button, and then select the color you
want from the Area Style/Filling drop-down list in the Line and Filling toolbar.
Repeat these steps for each element (state) on the map. Once you’ve colored
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Figure 2. Creating a map is as simple as dragging it from the Gallery onto
the drawing.

Figure 3. Each element of the map is drawn using Bézier curves.
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the map, leave the Edit Points mode by pressing F8. Now you have a
professional-looking map, but the fun doesn’t have to stop here. OOoHG
includes an impressive collection of design elements that you can use to add
virtually any type of information to the map. For example, let’s add Berlin to
the map. Select the Carto 1 Outils ponctuels géométriques theme, and drag
the dd2269 element onto the map. Place it where Berlin is supposed to be,
and adjust the circle’s size (to keep the circle’s proportions, press and hold
the Shift key while resizing the circle with the mouse). Select the colors you
like for the circle’s border and filling. Next, use the Text tool to add a city’s
name so you can identify it on the map.

Want to turn your creation into a weather map? OOoHG has what you
need. Select the Carto 2 Outils ponctuels expressifs theme, and use the
weather symbols (elements from dd2333 to dd2338) that represent different
weather conditions.

CREATING INTERACTIVE MAPS
The great thing about OOoHG is that it’s not limited to Draw; you 
can use it with other OpenOffice.org applications as well. And, 
using OOoHG with Impress is particularly intriguing, because it 
allows you to create interactive maps. For example, you can create 
an interactive weather forecast for several days using Impress’s built-in
tools and OOoHG.

Start with creating a blank Impression presentation. As you already
have the map of Germany with Berlin on it, you can just as well insert 
it from Draw into the presentation. Simply copy it in Draw and paste it
into the currently selected slide in the presentation. Add a header to the
slide—for example, Weather Today—and add the appropriate weather
symbol from OOoHG Carto 2 Outils ponctuels expressifs theme to the
map. Next, left-click on the slide in the Slides pane to the left, and
select Copy. Left-click anywhere in the Slides pane, and select Paste.
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Figure 4. OOoHG includes a wide range of map elements, including weather
symbols.

Figure 5. Using OOo Impress you can create interactive maps.
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This creates a new slide identical to the original one. Replace the header
with, for example, Weather Tomorrow, and replace the weather symbol
with another one (assuming the weather is going to be different the
next day, of course). To make the map a bit more snazzy, you can add
transition effects to the slides.

Now you can impress your peers by showing them your interactive
map, but you also can publish it on the Web either as an HTML or Flash
presentation. To export your interactive map in Flash format, choose
File→Export, and select the SWF format from the File format drop-down
list. This creates a Flash version of the interactive map, but before you

can publish it on the Web, you have to create an accompanying
HTML page and embed the .swf file into it. The most basic code can
be as follows (remember to substitute the “WeatherForecast.swf”
with the name of your Flash file):

<html>
<body><object width="800" height="600">
<param name="movie" value="WeatherForecast.swf">
<embed src="WeatherForecast.swf" width="800" height="600">
</embed>
</object>
</body>
</html>

Exporting the map into an HTML-based presentation is equally
easy. Choose File→Export, and select the HTML format from the
File format menu. This opens the HTML Export wizard that guides
you through the entire process.

FINAL WORD
This article has barely scratched the surface of what you can 
do with OOoHG. It is a truly amazing package that allows you
to create anything from historical maps and timelines to maps
of population density and immigration charts. The best part,
though, is OOoHG’s sheer ease of use. You can create professional-

looking maps with minimum effort and export them in a variety of formats.
If you need to create a map for your class or business presentation, look
no further than OOoHG.�

Dmitri Popov is a freelance writer whose articles have appeared in Russian,
British and Danish computer magazines. His articles cover open-source
software, Linux, Web applications and other computer-related topics.
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Figure 6. The exported Flash-based map can be published on the Web.
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KDE Kontact is a personal information manager that allows you to keep
track of many different types of information. It also can tie this information
to some brands of handheld devices. If you are in an office setting and have
a suitable office groupware server, you can use Kontact to keep up with
coworkers’ scheduled meetings and activities. For this feature, Kontact’s
motto is “Share information!”

One of the philosophies that always has been behind UNIX and related
operating systems, such as Linux, is that it normally is better to build several
small programs and tie them together than to build one monster program.
We see this philosophy in Kontact, which ties together several existing
programs in one very neat, slick package. In Kontact, the mail program is
KMail, and the calendar function is provided by KOrganizer and so on. The
big advantage to this idea is that if a serious bug is found in one area, it
affects only one function, not everything. It also means that upgrades can
be done in several areas at once.

To run Kontact, you need a copy of the Kontact software. In addition,
you need to have the KDE environment installed on your system. You don’t
actually need to be running KDE when you run Kontact, so if you’re a fan of
the GNOME desktop, you can run Kontact while using GNOME, just as long
as KDE has been installed on your system. Many Linux distributions do install
Kontact by default when they install KDE, so chances are good you already
have Kontact installed.

CONFIGURING KONTACT
So, let’s get to work with Kontact, starting with configuring the program.
From the top Settings menu, select Configure Kontact. Most of the settings
offered are ones of taste, such as what color to use to highlight overdue
to-do items. For these options, the program offers reasonable defaults. A

few settings, however, need to be changed before you can make proper use
of the program.

If you click Summary→Weather Service, you will see a list of locations,
many with further submenus. Select a place, and you will be able to see
weather forecasts for the location you chose. In my case, that meant clicking

KKDDEE  KKoonnttaacctt
How can the Kontact Personal Information Management suite help you? By uniting many popular KDE organization tools, the challenge is choosing which tool to use first.

COLIN MCGREGOR

Figure 1. Configuring Kontact’s Summary View
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on Canada→Ontario→Toronto, and then I clicked on Add to make sure I will
see forecasts from Toronto’s Pearson International Airport. After doing this,
or any other settings change, make sure to click Apply to save the change.
It’s a similar story under Summary→News—you decide which news Web site
headlines you would like to see on the Summary screen. Choices include
everything from eFilmCritic to CNN headlines—choose according to your
taste. Remember, again, to click Apply.

SETTING UP E-MAIL WITH KONTACT
Under Mail→Accounts things get a little bit tricky, as you need some infor-
mation from your Internet service provider(s), and if you’re setting this up in
an office setting, this may be mean your organization’s information technology
department. The mail program does support multiple e-mail accounts, so

for example, if you have an e-mail account for home, an e-mail account
for volunteer work and an office e-mail account, that is fine, but you
need information for each account. You can go back and modify infor-
mation, so correcting errors, and adding or dropping accounts is not a
big issue. Start by clicking Receiving→Add and entering a name under
Account name. Account name is for your benefit and should be some-
thing that will help you remember what this e-mail address is for, such
as Home, Charity or Office. The values that follow depend on your
Internet service provider. Once those values are entered, click on Extras
and check what the server supports to see how your e-mail server wants
to be talked to. Repeat this process for each e-mail account you want to
receive e-mail from.

Under Mail→Accounts→Sending, you need to create a default place
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Figure 2. Configuring the Weather Function for Toronto, Ontario, Canada Figure 3. Selecting Default News Feeds
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from which to send e-mail. As with receiving, the Name area is arbitrary,
and it can be anything that helps you remember the particular account.
The rest of the settings come from your Internet service provider.

Before we leave the setup of e-mail, you need to create an identity
under Mail Identity. Because forged e-mail addresses are easy to create,
and because forged addresses are used to help hide the origins of spam,
some service providers are taking a hard line against identities that don’t
appear to be one of theirs. So, for an identity, the safest route is to use
whatever you have set as your default Receiving identity.

USING KONTACT WITH HANDHELD DEVICES
There are times when a Linux-running laptop is not portable enough or
easy enough to use. Double-checking a grocery list at the supermarket 
is not something you want to do with a laptop. This is where handheld
devices like the Palm-based devices and some high-end cell phones
come into play. In this arena, Kontact works but is somewhat weak.
Kontact doesn’t currently support the Windows CE-based handheld
devices, and the KPilot program that Kontact uses to connect to Palm
devices has a reputation for being somewhat troublesome. So, do back
up the contents of your handheld with a program other than KPilot
before you start with Kontact.
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Figure 5. Setting up the system to deal with e-mail from within a local
machine—note that the mail folder /var/mail/<username> varies between
distributions, so double-check it for your system.

Figure 6. Managing E-Mail Identities with My Default E-Mail Address Partly
Obscured
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Turn your Palm device on, connect it to your computer and then go to
KPilot Configuration. Click on the Configuration Wizard and follow the
instructions given. If you run into problems here, which is very possible,
search engines such as Google are a lifesaver. The odds are excellent that
someone has run into the same problem you have and posted a way to
deal with said problem on-line.

At this point, the basic setup is done, and we are ready to start doing
interesting things with Kontact.

THE SUMMARY SCREEN
Let’s start with a quick look at the Summary screen. Simply click on

Summary, and you will see whatever you asked to see in setup. See
Figure 9 for an example from my system. Keep in mind that as the news
updates or as you change your to-do list, the Summary screen changes.

READING AND SENDING E-MAIL WITH KONTACT
Assuming the e-mail settings are correct, then clicking the Mail icon on the
left-hand side of the screen should bring up the e-mail screen. Depending
on the settings for KMail, you may have to check for e-mail manually. This is
what you may want if you are on a dial-up connection. The system can
check for e-mail automatically every several minutes, which is a great choice
for those with high-speed Internet connections.

Once you have your e-mail, sending e-mail is easy, with a few options
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Figure 7. Editing My Default Identity with My Default E-Mail Address Partly
Obscured

Figure 8. Configuration for KPilot
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available. Click on the New Message icon near the upper-left corner,
press Ctrl-N or click File→New Message. However you get there at this
point, you see a Composer screen where you can type up your message.
Clicking Select brings up a list of people currently in your address book.
Once you finish your message, to send it, press Ctrl then Enter, or select
File→Send Mail.

KONTACT’S TO-DO LIST
Managing the to-do list is about as easy as dealing with e-mail. There
are multiple ways to add new to-do items, including clicking on
Actions→New to-do. Simply fill in the boxes on the screen, and click
OK. If you’re not sure about dates, clicking on the little down arrow

beside the due date brings up a small calender screen from which you
can select dates. Over time, to-do items will change—a deadline may be
moved forward or back or a priority may change. All of this is altered
easily with Kontact. Simply double-click on the task that needs revision
and enter the changes. Once a task is totally finished, click in the little
square to the left of the item to mark it as completed. To get rid of all
the completed to-do items, click File→Purge Completed to-dos, and
follow the on-screen instructions.

KONTACT’S CALENDAR
The Calendar starts by listing items in your To-do list, so if you have
something like “Write proposal” on your to-do list for today, it will
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Figure 9. The Summary Screen Figure 10. Checking E-Mail (with Parts of Each E-Mail Address Hidden)
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show up on your calendar for today as an all-day event. To get to
Calendar, click Calendar on the left-hand side. Beyond that, it is easy to
add other things, say a doctor’s appointment or a staff meeting—things
with a clear start and hopefully clear stop time. Click File→New Event,
and enter the information. One neat feature that Calendar offers is the
recurrence feature. Some events will repeat on an expected schedule—
for example, a staff meeting that happens every Monday morning from
9:00 AM to 9:30 AM, except on the Labor Day holiday. Once you have
the New Event screen up, click Recurrence, then click the Enable recur-
rence box, and then enter the details about how the event reoccurs.
Other Calender functions include Attendees, which lets you track people
who are to attend an event, what their role is at the event and what if
any action they are to do as a result of the event.

MANAGING CONTACTS WITH KONTACT
For your contact list, click Contacts on the left-hand side. Next, select
File→New Contact, and then start entering information on the main screen
for the person you want to keep track of. Besides the usual things like name,
title, employer, address, phone number and e-mail address, Contacts also lets
you keep track of a person’s birthday, partner, anniversary, photo and geo-
graphic location—in longitude/latitude. All rather impressive!

KONTACT’S JOURNAL FEATURE
If you want to keep a diary of what you have accomplished, a Journal func-
tion lets you track day by day what you have done. Simply click Journal, click
on the little calendar box for the date that interests you, then click Add
Journal Entry and type in your notes.

TAKE NOTES WITH KONTACT
The small Notes function lets you create small files inside Kontact for use
with other programs.

CONCLUSION
The one weak area of Kontact is the connection to handheld devices. I have
had issues getting this set up, and once setup, I have, from time to time, lost
data while using the connection. So, if you have an old Palm device, like a
Palm III, and want to play with this feature, please do, but be aware that this
is the only part of Kontact that is not fully ready for prime time. The Kontact
developers have announced plans to replace KPilot with KitchenSync.
However, KitchenSync is still under development, and it is not yet considered
stable enough for general use.

So, in summary, KDE Kontact is a great tool to help organize your life—be
it keeping track of events, people and/or time. The only thing keeping me
from rating this a fantastic program is the weakness with connecting to
handheld devices. In all other areas, it is first rate!�

Colin McGregor works for a Toronto-area charity, does writing plus con-
sulting on the side and has served as President of the Toronto Free-Net.
In volunteer work, he is secretary for the Greater Toronto Area Linux User
Group meetings and is moderator for the Unix Unanimous user group.
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Figure 11. Creating a New To-Do Item
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For those who haven’t encountered IRC (Internet
Relay Chat) yet, IRC is a means of instant commu-
nication over the Internet. In that aspect, it is simi-
lar to instant messaging (IM) protocols/programs,
such as MSN, AIM and ICQ. The major differences
are that unlike most of the instant messaging pro-
grams, IRC primarily is used for communication in
groups (called channels), and you have to choose
a server on which you want to chat.

The advantage of such a concept is that
groups can be formed according to interest or
theme, which is something the FOSS (Free,
Open-Source Software) community utilizes
heavily. Almost every FOSS project has a chan-
nel of its own where users can ask for (and
give) help, and discuss ideas and problems 
concerning that project.

But, of course, IRC is still very usable as a
means of general chit-chatting and meeting inter-
esting people.

CLIENTS, SERVERS, CHANNELS AND MORE
So, what do you need to start chatting over
the world-wide IRC? First, you need a client.
No problem there—there’s a plethora of FOSS
IRC clients available for GNU/Linux, ranging
from console-based clients, such as BitchX and
Irssi, to those with a graphic interface, such as
Xchat, (Mozilla’s) Chatzilla and Konversation. If

you ask me, I’m more of a Irssi and
Konversation type of guy. Irssi is a nice con-
sole-based client that has features (especially
when it comes to usability) that some others
don’t have, and Konversation has the usability
and a clean look that you could split atoms on.
So, I mainly concentrate on Konversation in
this article, while still trying to teach you how
to survive in pretty much any other IRC client
out there using the standard IRC commands.

As already mentioned, there’s a vast number
of servers to which you can choose to connect.
Some servers are dedicated for specific uses
only (for example, irc.freenode.net for FOSS
projects), and others are generally open for any
topic whatsoever.

Another special characteristic of IRC is chan-
nels. In its essence, what defines a channel is its
name, usually prefixed with a hash sign (for exam-
ple, #gentoo) and its topic. As a small tip so you
don’t get lost, it is quite common to refer to a
specific channel on a specific server like this:
#gentoo@irc.freenode.net, which means the
#gentoo channel on the irc.freenode.net server.

FIRST STEPS—GETTING SOMEWHERE
Because Konversation is quite popular and is most
likely to ship with your distribution, I’m not going
to teach you how to install it—simply use emerge

or apt-get install (or whatever you use) to
install it. Once it’s installed, you can start it by 
running konversation on the command line, or
in KDE, from the K menu: Internet→IRC Chat
(Konversation). You will see something like what is
shown in Figure 1. To begin, you can use the
default settings, and simply clicking Connect→
Konversation sets up a connection to the
Freenode server by default and automatically joins
the #kde channel (on some distributions it might
be some other channel—for example, #debian-kde).
Also, it guesses the default identity from your user
information. The nickname is set as your user

IIRRCC::  WWhhaatt  IItt  IIss  aanndd  WWhhyy  WWee  UUssee  IItt
Sooner or later, we all need to obtain support from an open-source project. Internet Relay Chat is the most direct way
possible to obtain that support. In this article, Matija Suklje explains the IRC basics to get you started with Konversation.

MATIJA SUKLJE

Figure 1. Konversation’s Startup Screen
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name, and
the real name
comes from
your user
account set-
tings. When
you finish
connecting,
you are pre-
sented with
the screen

shown in Figure 2. From here on, you can start
typing messages right away, and when you press
Enter, your typed text is sent to the channel and is
shown in the main area of the window.

But, surely there must be more to the inter-
face. And, there is. On the right-hand side, there’s
a list of the users present on the channel, and if
you double-click someone’s nickname, it opens a
new tab with a private chat (called query in IRC
terms) with that person. This is rather useful when

you need to talk to someone person to person
without others being bothered with the conversa-
tion. Right on top of the chat area and the user
list is the topic of the channel—sometimes a lot of
useful information is available in the topic (for
example, behaviour rules and frequently asked
questions). Below the two main areas is a pull-
down menu where you can choose your nickname
if you use an identity that has more than one
nickname (more about identities later) and the
text bar where you enter text. Remember not to
write too much at the same time. Many channels
consider big blocks of text as spam, and you can
get kicked off or even banned from a channel.
Below that are the
channel tabs. Each
channel (even the
server’s notifica-
tions and queries)
has one, so you
easily can switch
between them.

To join a new
channel, let’s say
#konversation, 
you either can
open up a dialog
with File→Join
Channel (shortcut:
Ctrl-J) and enter
your choice or
enter the name 
of the channel 
in the pull-down
menu as shown 
in Figure 3.
Alternatively, 
you can type the

IRC command (for example, /join #konversation)
in the text box of any channel. To leave a channel,
you either can press Ctrl-W (in menu: Window→
Close Tab) or press the close tab on the right-hand
bottom part of the window.

GETTING MORE OUT OF THE EXPERIENCE
Now that you understand the survival basics,
you’re probably hungry for more. Here’s a few IRC
features and some Konversation gems you just
have to know about.

Let’s assume a typical situation: you’re in the
middle of a conversation with several channels and
you have to leave for lunch. You wouldn’t want to
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Figure 2. The Normal View, Showing the Channel
Tabs, Chat Window and Users’ List

Figure 4. Going Away and Back Again

Figure 3. Join a Channel
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miss messages that are meant for you, and you
probably want to let others know you’re not there
as well. No problem—simply mark yourself as
away by going to File→Global Away or by clicking
the global away button on the toolbar. When you
return, do the same to “get back”, and you’ll be
presented with all the lines that people sent with
your nickname in them. You can change the mes-
sage that’s being displayed when you enter your
away status and leave it in the settings for your
identity. In Konversation, every identity can have a
different away and coming back message.

I’ve mentioned identities many times already, so
I feel I should explain their significance. This is a
Konversation feature, but it makes life easier if you
talk on different servers (such as Freenode for
FOSS and another one for random chatting) on
which you use different nicknames or different set-

tings. You can change the settings in Konversation
to support adding more nicknames in case one
gets taken while you’re off-line or changing your
away messages and auto identify, which is quite
useful on servers like Freenode (which has an
option to register your nickname with a password
to a service bot like NickServ in Freenode’s case, so
your nickname doesn’t get taken). You can access
all this identity magic from Settings→Identities
(shortcut: press F8; see Figure 5).

Now, let’s say you have a number of channels
you want to join automatically, each time you con-
nect to a specific server (or you want to disable
auto-joining to #kde). You can do this by editing
the settings of a network by clicking Edit on the
selected network in the Server List window, which
is the first window to show up when you start up,
and it also is accessible by going to File→Server
List (shortcut: F2). You’re presented with a rather
self-explanatory window, as shown in Figure 6. The
channels in the auto-join list will be loaded in the

order they are in—top entry will be joined first.
This is even more important in the server list,
because it starts to connect to the topmost server
first, and then to the one next in line and so on.

There’s also a lot of global settings that allow
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Figure 5. Configure more settings for your identity.

Figure 6. Adding servers and Auto-Join Channels
to a Network and Changing the Identity

Figure 7. Configuration Window

Figure 8. DCC Tab with One Outgoing File Transfer
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you to tweak the behavior of Konversation, avail-
able from Settings→Configure Konversation
(Figure 7). These settings range from look and feel
to advanced settings, such as setting your own
command aliases and shortcuts. Among the more
interesting preset command aliases is the /media
command, which if typed, shows the information

about the song currently played on your favorite
media player. If you’re waiting for someone to
bring up a certain topic, the highlight settings also
are most welcome—you can add which word (or
string) Konversation should look for and in which
color it should highlight it.

Of course, sometimes you will want to

transfer files over IRC as well—show off screen
shots or share configuration files, for example.
This is done simply by right-clicking on the
name of the person you want to send the file
and selecting Send File. When you select the
file from the dialog, a new tab opens where all
the file transfers (incoming and outgoing) are
shown. In IRC terms, this is called a DCC file
transfer. DCC stands for Direct Client-to-Client.
If you need to receive a file, Konversation
opens a pop-up window asking if you want to
accept or decline the transfer.

Note that if you want to send files and you are
behind a router or firewall, you will have to set
NAT/port-forwarding and match the ports with the
ones used by Konversation for the DCC send. By
default, Konversation (in version 0.19) uses the
port range 1025–7000. If you don’t want to have
as many ports open, there’s no reason to let
Konversation try them, so you can shorten the
range in Settings→Configure Konversation under
the DCC tab. While configuring ports, you also can
change (among other settings) the folder into which
Konversation saves the files it receives over DCC.

CONCLUSION
As you can see, starting to use IRC isn’t hard at all.
And, when you get to know it a bit better, you can
do all sorts of things with it. It’s all even more simple
with an easy-to-use client like Konversation.�

Matija Suklje is a 21-year-old law student and member of
Cyberpipe from Ljubljana, Slovenia who has been interested in
Linux and F(L)OSS since his early high-school days when he first
met Slackware. Currently, his favourite distribution is Gentoo.
You can contact him via e-mail at matija.suklje@rutka.net or
from his new home page (http://matija.suklje.name).
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EXAMPLES OF THE MOST COMMON IRC COMMANDS

� /connect irc.freenode.net — connects the client to the irc.freenode.net server.

� /join #gnome — joins the #gnome channel.

� /part — leaves the channel in which it was typed/ran.

� /part< #gnome — leaves the #gnome channel from wherever it was executed.

� /query silver_hook — starts a private conversation with silver_hook. If such a conversation is
already running, it closes it.

� /me does something funny — in this case, the nickname is silver_hook, so this command
displays silver_hook does something funny.

� /dcc send screenie.png silver_hook — sends/offers user silver_hook the file screenie.png.

� /dcc accept screenie.png silver_hook — accepts the offer and downloads the file
screenie.png from user silver_hook.

� /nick hook — changes the nickname to hook.

� /whois silver_hook — displays more information on user silver_hook.

� /help — lists all the IRC commands available on the server.

� /quit — disconnects and quits the IRC client.

http://matija.suklje.name
http://www.tuxmagazine.com
mailto:matija.suklje@rutka.net


In one of the first packages that targets families, the
Linux Loft has created a very welcome entry to the
TUX review section. The computer, named the Linux
Loft Family Box, is intended to orient school-age
children to free and open-source software. This
durable desktop is pre-installed with Edubuntu,
a Linux distribution whose motto is “Linux for
young human beings.”

In this review, we take a look at the entire
package, but we pay most of our attention to
Edubuntu and the customizations Linux Loft has
done to make the package more complete and
satisfying for families.

INSTALLATION
Because the Family Box comes pre-installed with
Edubuntu, there isn’t much left to set up. Simply
connect the keyboard, mouse, power, speakers and
Ethernet cables in their respective sockets, and turn
on the box. The system should boot up properly,
and then you’ll be prompted with the Edubuntu
login screen. Because the software comes pre-
installed, I’d say the installation was good.

EASE OF USE
As the name might suggest, the Edubuntu distri-
bution is based on the Ubuntu distribution. As
such, it comes with the GNOME desktop. You will
quickly notice that the look of the desktop is dif-
ferent. According to the Edubuntu home page, it
provides three different theme setups: Young, for

younger users; Plain, for a clean desktop setup;
and Default, which is a general-purpose theme
setup. On startup, the Linux Loft Family Box
displayed the Young theme. With bright colors
and cartoon-like icons, the theme is inviting and
appealing—according to my kids.

A few simplifications made to the default
menu system make Edubuntu easier to use but a
little confusing for experienced GNOME desktop
users. Edubuntu targets a wide range of children
(ages 6–18), so there are a wide range of games
and educational tools. Although older kids will
find the distribution easy to use, younger children

may require some guidance and support from par-
ents. Although Linux desktop software is relatively
easy to use, it is still based on a user interaction
standard that is not intuitive for young children—
that is, menus, choosing options to start applica-
tions and windows.

Of course, my perception could be spoiled.
Earlier this year at the Boston LinuxWorld, I
attended a “One Laptop Per Child Birds of a
Feather” session, where the presenters unveiled 
a mock-up prototype of the desktop for the new
computers. These computers, obviously designed
with children in mind, will have a tabbed inter-
face, which will cycle through tabs so that you
can never lose a window. This style of interface
seems more suitable for younger children.

I think Edubuntu suffers from trying to be all
things for all kids. For children aged 6–10, the 
system still requires extensive adult supervision; 
for children aged 10–14, less so; and for children
older than 14, I’m not even sure Edubuntu is
appropriate. I don’t see anything that would
attract their attention. For ease of use, I give
the Family Box with Edubuntu a poor rating for
children aged 6–10, and an average ease of use
rating for children aged 10–14.

MAINTENANCE
As Edubuntu is based on the Debian distribution,
it features the standard apt and Synaptic package
manager for updates. After unpacking and
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LLiinnuuxx  LLoofftt::  FFaammiillyy  BBooxx  wwiitthh  EEdduubbuunnttuu
Linux Loft’s bold stand in delivering free and open-source software to children is very commendable; however, Edubuntu shouldn’t try to be all things to all children.

KEVIN SHOCKEY

Figure 1. Default Young Theme for Edubuntu and
the Family Box
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installing the Family Box, once the system was
powered on and we were logged in, Synaptic 
validated the installed packages and immediately
informed me, via a flashing icon in the task bar in
the upper right-hand corner, that updates were
available. Installing the updates was only a couple
clicks away.

As mentioned before, Edubuntu uses the
GNOME desktop. Therefore, the system also
includes the Gnome App Installer. This application 
is an easy-to-use interface that simply displays the
most common applications for each application 
category. Using large cartoon-like icons, the App
Installer simplifies the process of finding new appli-
cations. To install a new application, browse the
directory tree of applications, click the check box 
of any application without a check mark, and then
click Apply. The App Installer confirms your selection
with a pop-up dialog window, and then you need
to click on the Apply button in the dialog. The
system then downloads the application from the
on-line repository and completes the installation.
Before finalizing the installation, the system displays

the results of setting up the application. Click Close,
and the application installation completes.

Right before testing the Family Box, the Ubuntu
Project released the Dapper Drake, Ubuntu 6.06
LTS version. While running the initial update, we
received a message that this process would not
complete the upgrade to the new version, and
that to complete the upgrade, we needed to visit
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Figure 2. Synaptic Package Manager Figure 3. Gnome App Installer

Figure 4. Initiate GPeriodic Application Installation

Figure 6. Finished Setting Up GPeriodic Application

Figure 5. Confirm Package Installation Dialog
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https://wiki.ubuntu.com/DapperUpgrades. We did
not complete this upgrade during this review.

Due to the combined availability of apt,
Synaptic and the App Installer, we give the Family
Box/Edubuntu combination an excellent rating.

DOCUMENTATION
Included in the Linux Loft Family Box package is
an Edubuntu Edition of Linux Loft’s Getting
Started Guide. This guide is intended for some-
what experienced computer users so they can
appropriately assist young children using Linux.
The guide covers some initial steps for getting
started. The guide is not meant as a replacement
for the help included with Edubuntu (available
from clicking on the question mark) or on-line
Ubuntu resources. Linux Loft’s intention for this

guide is to give parents, who may have never
used Linux, a tool to ease their children’s 
challenge of learning Linux.

The help included with Edubuntu is available
via the Yelp documentation browser and viewer
for the GNOME desktop. There are two sources of
Ubuntu help, “About Ubuntu” and “The Ubuntu
Starter Guide”.

Between the Getting Started guide and the
help included with Ubuntu, I give the Family Box a
good rating for documentation. One recommen-
dation I would make for Linux Loft is to include
screenshots in the guide. As you can see from
reading TUX, we believe that screenshots signifi-
cantly increase comprehension.

CAPABILITY
Although Edubuntu is labeled as “Linux for young
human beings”, and the Family box is intended to
orient school-age children to free and open-source

software, the extension of this system to be all
things for anyone in the family is a disservice to
children. Now with some tweaking for each user,
one might be able to configure each to be more
age- and task-appropriate; however, doing this was
not covered in the Getting Started Guide. On the
other hand, in a world filled with music, cable TV,
video games and more, I’m not sure what is the
best way to orient young people to free and open-
source software, but this is a great first step.
Creating a computer that contains nothing but free
and open-source software is to be commended.

So, let’s examine Edubuntu as Linux for young
human beings. Quoting from the Edubuntu home
page, “it aims to bring the spirit of Ubuntu to
schools, through its customized school environ-
ment. The current version of Edubuntu is designed
for classroom use, and future versions of Edubuntu
will expand to other educational usage, such as
university use.” As stated earlier, this fits with my
perception. Edubuntu would work well in a class-
room setting. With teacher supervision, students
would respond well to Edubuntu. Moving beyond
the 6–14 year range, however, Edubuntu was
nothing special. As claimed though, as Edubuntu is
fundamentally Ubuntu, it is capable of everything
available from a standard Ubuntu distribution.

My daughter is 11, and she was pretty happy
when she saw the long list of games available—
and she didn’t even see the longer list available
within the Debian application repositories. So, for
children, Edubuntu is very capable. Edubuntu
comes with 26 education games. The majority of
the games are for languages, math and science.
Although a good start, I hope that the Edubuntu
Project can add a lot more programs and games
to this category.

In terms of rating the Family Box/Edubuntu
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Figure 7. GPeriodic Application Installation
Complete

Figure 8. Edubuntu help is included with standard
installation.
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combination for capability, I’m split. For children, I
think it’s between average and good. With the
addition of more education-focused applications,
it could be good. However, as a tool for the fami-
ly, Edubuntu is no more capable than any other
distribution, so I have to give it an average rating.

SUPPORT
For this review, we did not have the opportunity
or need to assess support for the Family Box.
According to the Web site, Linux Loft offers a 
30-day warranty on the purchase, completed by
returning the unit to the manufacturer. Linux Loft
also offers an optional three-year, next-day, on-site
warranty, which is available at order time. The
extended warranty costs $149 US.

Software support for Edubuntu is available only

from the Edubuntu/Ubuntu community. Options
available include the wiki (http://edubuntu.org/
community), the IRC channel (irc.freenode.net,
called #edubuntu) and mailing lists. Other Linux
community support sources are also available.

In general, the Family Box relies too much on
the community for support of the software. The
hardware support is average, but the support for
Edubuntu from Linux Loft needs to improve. I give
its software support a poor rating.

PRICE
Let’s be clear when we examine the pricing for the
Family Box. According to the Edubuntu manifesto,
Edubuntu will always be free of charge. Therefore, all
costs associated with the offering are directly related
to the hardware and the customization necessary to
install Edubuntu and tweak the configuration.

When comparing the hardware to similarly
priced systems, the first thing I found was that
there aren’t many non-refurbished desktops
around at that price range. The few that I did
find also come pre-installed with Linux. So in
comparison to non-refurbished systems, the
Family Box is excellent. However, in comparison
to other pre-installed Linux machines, the price
is poor. We’ll split the difference and give the
Linux Loft Family Box a slightly above average
rating for price.

CONCLUSION
Offering this PC for sale with the Edubuntu Linux
distribution is a bold and creative move by the
Linux Loft. It shows great leadership and belief in
free and open-source software. I predict that
when the One Laptop Per Child makes its inter-
face available, Edubuntu will quickly move to
embrace the new interface and will significantly

improve the usability and capability of the Edubuntu
distribution. Until then, through its leadership
and prepackaged offer, Linux Loft pushes the
Linux desktop closer to reality.

With improved usability for younger children, an
even wider variety of education games and improved
support for Edubuntu, Linux Loft could have an
extremely valuable offer for families everywhere.�

Kevin Shockey is Editor in Chief of TUX.

REVIEWS

50www.tuxmagazine.com

SUMMARY

INSTALLATION: good

EASE OF USE: depends (poor for ages 6–10,
average for ages 10–14)

MAINTENANCE: excellent

DOCUMENTATION: good

CAPABILITY: average

SUPPORT: poor

PRICE: average

OVERALL RATING: average

LINUX LOFT FAMILY BOX

URL: http://www.linuxloft.com/
product_info.php?cPath=22&products_id=42

PRICE: $443 US

DISTRIBUTION: Edubuntu (Warty Warthog)

HARDWARE PROFILE:
� Celeron 2.6GHz
� Slimline case
� 256MB of memory
� 80GB+ hard drive
� 104 keyboard
� Mouse
� DVD-combo drive (reads DVDs, reads and

writes CDs and CDRWs)
� Video built-in
� Sound built-in
� Network interface

http://edubuntu.org/community
http://www.linuxloft.com/product_info.php?cPath=22&products_id=42
http://www.tuxmagazine.com
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